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Preface
Introduction

Desktop Administrator is a “container” program. This program allows you to access 
various other applications used to administer Cisco Agent Desktop, Cisco Agent 
Desktop—Browser Edition, Cisco Supervisor Desktop, and Cisco IP Phone Agent from 
within one interface. 

NOTE:  Desktop Administrator is not supported if installed on a virtual 
private network (VPN) desktop.

What’s New in This Release

Cisco Desktop Administrator 7.2 includes the following new features:

■ Ability to import and export actions from one work flow group to another and 
between instances of Desktop Administrator

■ Support for Cisco Unified Communications Manager-based silent monitoring 
via an IP phone as an alternative to CAD-based (desktop or server) 
monitoring.

Desktop Administrator Feature Levels

There are three feature levels of Cisco Desktop Administrator: Standard, Enhanced, 
and Premium. The following chart outlines the features available in each feature level. 
All features not listed here are present at all three feature levels.

Table 1. Cisco Desktop Administrator feature levels 

Feature Standard Enhanced Premium

Configure CAD interface × ×

Configure work flows × ×
13
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Related CAD Documentation

The following documents contain additional information about CAD 7.2:

■ Cisco CAD Installation Guide

■ Cisco Agent Desktop User Guide

■ Cisco Agent Desktop—Browser Edition User Guide

■ Cisco Supervisor Desktop User Guide

■ Cisco IP Phone Agent User Guide

■ Mobile Agent Guide for Cisco Unified CC Enterprise

■ Cisco CAD Service Information

■ Integrating CAD Into a Citrix MetaFrame Presentation Server or Microsoft 
Terminal Services Environment

Obtaining Documentation

Cisco documentation and additional literature are available on Cisco.com. Cisco also 
provides several ways to obtain technical assistance and other technical resources. 
These sections explain how to obtain technical information from Cisco Systems.

Cisco.com

You can access the most current Cisco documentation at this URL:

http://www.cisco.com/techsupport

Configure task buttons for Agent Desktop 
toolbar

× ×

Configure CAD integrated browser ×

Configure CAD-BE integrated browser × ×

Time of day event and data condition ×

CAD agent work flow HTTP Post/Get 
action

×

CAD-BE agent work flow HTTP Post/Get 
action

× ×

IPC Receive event ×

Table 1. Cisco Desktop Administrator feature levels — <Emphasis>Continued

Feature Standard Enhanced Premium
14 June 2007
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You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Product Documentation DVD

The Product Documentation DVD is a comprehensive library of technical product 
documentation on a portable medium. The DVD enables you to access multiple 
versions of installation, configuration, and command guides for Cisco hardware and 
software products. With the DVD, you have access to the same HTML documentation 
that is found on the Cisco website without being connected to the Internet. Certain 
products also have .PDF versions of the documentation available.

The Product Documentation DVD is available as a single unit or as a subscription. 
Registered Cisco.com users (Cisco direct customers) can order a Product 
Documentation DVD (product number DOC-DOCDVD= or DOC-DOCDVD=SUB) from 
Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/

Ordering Documentation

Registered Cisco.com users may order Cisco documentation at the Product 
Documentation Store in the Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/

Nonregistered Cisco.com users can order technical documentation from 8:00 a.m. to 
5:00 p.m. (0800 to 1700) PDT by calling 1 866 463-3487 in the United States and 
Canada, or elsewhere by calling 011 408 519-5055. You can also order 
documentation by e-mail at tech-doc-store-mkpl@external.cisco.com or by fax at 
1 408 519-5001 in the United States and Canada, or elsewhere at 011 408 
519-5001.

Documentation Feedback

You can rate and provide feedback about Cisco technical documents by completing 
the online feedback form that appears with the technical documents on Cisco.com.

You can submit comments about Cisco documentation by using the response card (if 
present) behind the front cover of your document or by writing to the following 
address:
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Cisco Systems 
Attn: Customer Document Ordering 
170 West Tasman Drive 
San Jose, CA 95134-9883

We appreciate your comments.

Cisco Product Security Overview

Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_
policy.html

From this site, you will find information about how to:

■ Report security vulnerabilities in Cisco products.

■ Obtain assistance with security incidents that involve Cisco products.

■ Register to receive security information from Cisco.

A current list of security advisories, security notices, and security responses for Cisco 
products is available at this URL:

http://www.cisco.com/go/psirt

To see security advisories, security notices, and security responses as they are 
updated in real time, you can subscribe to the Product Security Incident Response 
Team Really Simple Syndication (PSIRT RSS) feed. Information about how to subscribe 
to the PSIRT RSS feed is found at this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

Reporting Security Problems in Cisco Products

Cisco is committed to delivering secure products. We test our products internally 
before we release them, and we strive to correct all vulnerabilities quickly. If you think 
that you have identified a vulnerability in a Cisco product, contact PSIRT:

■ For Emergencies only — security-alert@cisco.com

An emergency is either a condition in which a system is under active attack or 
a condition for which a severe and urgent security vulnerability should be 
reported. All other conditions are considered nonemergencies.

■ For Nonemergencies — psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

■ 1 877 228-7302
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■ 1 408 525-6532

TIP:  We encourage you to use Pretty Good Privacy (PGP) or a 
compatible product (for example, GnuPG) to encrypt any sensitive 
information that you send to Cisco. PSIRT can work with information 
that has been encrypted with PGP versions 2.x through 9.x.  
 
Never use a revoked or an expired encryption key. The correct public 
key to use in your correspondence with PSIRT is the one linked in the 
Contact Summary section of the Security Vulnerability Policy page at 
this URL: 
 
http://www.cisco.com/en/US/products/products_security_
vulnerability_policy.html 
 
The link on this page has the current PGP key ID in use. 
 
If you do not have or use PGP, contact PSIRT at the aforementioned 
e-mail addresses or phone numbers before sending any sensitive 
material to find other means of encrypting the data.

Obtaining Technical Assistance

Cisco Technical Support provides 24-hour-a-day award-winning technical assistance. 
The Cisco Technical Support & Documentation website on Cisco.com features 
extensive online support resources. In addition, if you have a valid Cisco service 
contract, Cisco Technical Assistance Center (TAC) engineers provide telephone 
support. If you do not have a valid Cisco service contract, contact your reseller.

Cisco Technical Support & Documentation Website

The Cisco Technical Support & Documentation website provides online documents 
and tools for troubleshooting and resolving technical issues with Cisco products and 
technologies. The website is available 24 hours a day, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support & Documentation website requires 
a Cisco.com user ID and password. If you have a valid service contract but do not have 
a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

NOTE:  Use the Cisco Product Identification (CPI) tool to locate your 
product serial number before submitting a web or phone request for 
service. You can access the CPI tool from the Cisco Technical Support 
& Documentation website by clicking the Tools & Resources link 
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under Documentation & Tools. Choose Cisco Product Identification 
Tool from the Alphabetical Index drop-down list, or click the Cisco 
Product Identification Tool link under Alerts & RMAs. The CPI tool 
offers three search options: by product ID or model name; by tree 
view; or for certain products, by copying and pasting show command 
output. Search results show an illustration of your product with the 
serial number label location highlighted. Locate the serial number 
label on your product and record the information before placing a 
service call.

Submitting a Service Request

Using the online TAC Service Request Tool is the fastest way to open S3 and S4 
service requests. (S3 and S4 service requests are those in which your network is 
minimally impaired or for which you require product information.) After you describe 
your situation, the TAC Service Request Tool provides recommended solutions. If your 
issue is not resolved using the recommended resources, your service request is 
assigned to a Cisco engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests, or if you do not have Internet access, contact the Cisco 
TAC by telephone. (S1 or S2 service requests are those in which your production 
network is down or severely degraded.) Cisco engineers are assigned immediately to 
S1 and S2 service requests to help keep your business operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227) 
EMEA: +32 2 704 55 55 
USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity

To ensure that all service requests are reported in a standard format, Cisco has 
established severity definitions.

Severity 1 (S1)—An existing network is down, or there is a critical impact to your 
business operations. You and Cisco will commit all necessary resources around the 
clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant 
aspects of your business operations are negatively affected by inadequate 
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performance of Cisco products. You and Cisco will commit full-time resources during 
normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of the network is impaired, while most 
business operations remain functional. You and Cisco will commit resources during 
normal business hours to restore service to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, 
installation, or configuration. There is little or no effect on your business operations.

Obtaining Additional Publications and Information

Information about Cisco products, technologies, and network solutions is available 
from various online and printed sources.

■ The Cisco Product Quick Reference Guide is a handy, compact reference tool 
that includes brief product overviews, key features, sample part numbers, and 
abbreviated technical specifications for many Cisco products that are sold 
through channel partners. It is updated twice a year and includes the latest 
Cisco offerings. To order and find out more about the Cisco Product Quick 
Reference Guide, go to this URL: 

http://www.cisco.com/go/guide

■ Cisco Marketplace provides a variety of Cisco books, reference guides, 
documentation, and logo merchandise. Visit Cisco Marketplace, the company 
store, at this URL:

http://www.cisco.com/go/marketplace/

■ Cisco Press publishes a wide range of general networking, training and 
certification titles. Both new and experienced users will benefit from these 
publications. For current Cisco Press titles and other information, go to Cisco 
Press at this URL:

http://www.ciscopress.com

■ Packet magazine is the Cisco Systems technical user magazine for 
maximizing Internet and networking investments. Each quarter, Packet 
delivers coverage of the latest industry trends, technology breakthroughs, and 
Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, 
certification and training information, and links to scores of in-depth online 
resources. You can access Packet magazine at this URL:

http://www.cisco.com/packet

■ iQ Magazine is the quarterly publication from Cisco Systems designed to help 
growing companies learn how they can use technology to increase revenue, 
streamline their business, and expand services. The publication identifies the 
challenges facing these companies and the technologies to help solve them, 
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using real-world case studies and business strategies to help readers make 
sound technology investment decisions. You can access iQ Magazine at this 
URL:

http://www.cisco.com/go/iqmagazine

or view the digital edition at this URL:

http://ciscoiq.texterity.com/ciscoiq/sample/

■ Internet Protocol Journal is a quarterly journal published by Cisco Systems for 
engineering professionals involved in designing, developing, and operating 
public and private internets and intranets. You can access the Internet 
Protocol Journal at this URL:

http://www.cisco.com/ipj

■ Networking products offered by Cisco Systems, as well as customer support 
services, can be obtained at this URL:

http://www.cisco.com/en/US/products/index.html

■ Networking Professionals Connection is an interactive website for networking 
professionals to share questions, suggestions, and information about 
networking products and technologies with Cisco experts and other 
networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking

■ World-class networking training is available from Cisco. You can view current 
offerings at this URL:

http://www.cisco.com/en/US/learning/index.html
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About This Document
About This Document

Intended Audience

This document is written for contact center system administrators who use Desktop 
Administrator.

Conventions Used

This document uses the following conventions:

Convention Use

Bold Highlights keys, buttons, and menu items you can 
select in the interface.

Code Highlights file paths and code.

Italic Highlights book titles, variables, and terms that are 
defined.

> The angle bracket indicates a menu choice. For 
example, “choose File > Open” means “click the File 
menu, and then click Open.”
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Getting Started
Starting Desktop Administrator

Desktop Administrator comes with 4 licenses, one for each node in the navigation 
tree. There can be only one user at a time working in each node. If someone is using a 
node that you must access, an error message appears that identifies the IP address of 
the computer accessing that particular node. 

NOTE:  If the LRM service is down, the error message will only tell you 
that another user is using the node. The IP address will not be 
available.

For this reason, it is important that you close Desktop Administrator completely when 
you are done using it. As long as the application is running, a license is being used and 
others are blocked from accessing the node selected in your instance of the 
application.

To start Desktop Administrator:

■ Choose Start > Programs > Cisco > Desktop > Admin. 

Desktop Administrator starts.
23
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Automated Updates

CAD can be configured during installation so that every time you start Desktop 
Administrator, it checks to see if there is an updated version available. If there is, it 
automatically runs the update process. 

NOTE:  For automated updates to function correctly, Internet Explorer 
must be configured so that it checks for newer versions of stored 
pages. In Internet Explorer, choose Tools > Internet Options and 
select the General tab. In the Temporary Internet Files section, click 
Settings and ensure that the “Every visit to the page” option is 
selected.

NOTE:  Automated updates are disabled for Windows Vista.

When this happens, you will see a dialog box notifying you that your copy of Desktop 
Administrator will be updated.

Click OK and then follow the instructions in the series of dialog boxes that follows.

When the update is finished, you will see a final dialog box telling you that your update 
is complete. When you click OK, restart Desktop Administrator.
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The Desktop Administrator Interface

The Desktop Administrator interface has two panes. The left pane is a navigation tree 
similar to that found in Windows Explorer. The right pane displays the application that 
you choose in the left pane. 

Figure 1. The Desktop Administrator interface. In this example, the Dial Strings node is 
selected in the left pane and displayed in the right pane.

The root of the navigation tree is Locations. Underneath Locations is the logical 
contact center set up in your system. Underneath the logical contact center is a list of 
the applications that administer Agent Desktop, Agent Desktop—Browser Edition, 
Supervisor Desktop, and IP Phone Agent.

Toolbars and Menu Bars

When you select a node on the navigation tree, the Desktop Administrator menu bar 
and toolbar change to reflect the design of that node’s application. 
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The toolbar buttons you see are among those listed in Table 1. 

Navigation Tree Pane

Use these mouse or keyboard actions in the left pane to navigate the tree.

Mouse

■ Double-click an icon/application name to expand or collapse the tree.

■ Click the plus sign ( + ) to expand the tree.

■ Click the minus sign ( – ) to collapse the tree.

■ Right-click to delete a node (not available for all nodes).

Keyboard

With a node selected,

■ Press the up and down arrow keys to move from one node to the next.

■ Press the left arrow key to collapse the tree.

■ Press the right arrow key to expand the tree.

Table 1. Desktop Administrator toolbar buttons.

Button Name Description

About Displays copyright and version information

Delete Removes the selected work flow group

Remove VoIP, 
Record/Playback 
Services

Removes unneeded services from Directory 
Services

Help Accesses Help files

New Adds a new work flow group 

Properties Displays the URL of the selected subnode 
under the Unified CCE Configuration node

Web Opens your web browser and accesses 
Cisco’s website
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Display Pane Navigation

The applications displayed in the right pane are designed to use shortcut keys and the 
tab key as alternatives to using the mouse to navigate around a window. The shortcut 
keys that apply to a specific node are discussed in the section devoted to that node’s 
functions.
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User Privileges in Windows 2000 and 
Windows XP

Because Desktop Administrator users must be able to update registry settings, they 
must have Administrator or Power User privileges on Windows 2000 Professional and 
Windows XP platforms. 

Only a person with Administrator privileges can change the user privileges on the 
Administrator PC if it is necessary to upgrade those user privileges.
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Passwords

A password is optional for Desktop Administrator. By default, no password is required.

If a password is configured, you are prompted for the password when you select the 
Call Center 1 node. The password is not specific to one user, but must be entered by 
anyone trying to access Desktop Administrator’s functionality.

To set up a password:

1. In the navigation pane, select the Call Center 1 node.

2. Choose Setup > Change Password. 

The Administrator Password dialog box appears (see Figure 2).

Figure 2. Administrator Password dialog box.

3. Leave the Old password field blank, and enter a new password, type it again 
to confirm it, and then click OK. 

Passwords are case sensitive and may consist of one or more alphanumeric 
characters. 

Desktop Administrator is now password protected. You must restart the 
application for the change to go into effect.

To change your password:

1. In the left pane, select the Call Center 1 node.

2. Choose Setup > Change Password.

The Change Password dialog box appears (see Figure 2).

3. Enter your old password, a new password, and your new password again to 
confirm it, and then click OK.

Your Desktop Administrator password is now changed. You must restart the 
application for the change to go into effect.
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To remove password protection:

1. In the left pane, select the Call Center 1 node.

2. Choose Setup > Change Password.

The Change Password dialog box appears (see Figure 2).

3. Enter your old password, leave the New password and Confirm password 
fields blank, and then click OK.

4. You are asked to confirm that you want to leave Desktop Administrator 
unprotected. Click Yes.

The Desktop Administrator password has been removed. You must restart the 
application for the change to go into effect.

Agent Desktop User ID, Login Name, and Password

Agent Desktop user IDs, login names, and passwords are set up in the ICM software 
and can be administered only through the ICM software. The user’s Agent Desktop 
password is verified on the CTI server when a user starts the application.

Use the ICM software to change a user’s Agent Desktop password if it becomes 
necessary to do so.

Supervisor Desktop User ID, Login Name, and 
Password

A user’s Supervisor Desktop user ID and login name are the same as the user’s Agent 
Desktop user ID and login name, and are set up in the ICM software. 

The first time Supervisor Desktop is started, the password is blank. It is up to the 
supervisor to create a password using the Change Password functionality within 
Supervisor Desktop. 

The Supervisor Desktop password can be changed from within Supervisor Desktop or 
from the Personnel node in Desktop Administrator (see "Supervisors" on page 173 for 
more information). 
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CAD Configuration Setup Utility

Use the Cisco Agent Desktop Configuration Setup utility to configure the CAD services. 
The Configuration Setup utility consists of a series of data entry windows. You must 
complete all of the windows in the utility to install and run CAD services successfully.

The Configuration Setup utility has two modes: Initial and Update. The utility is 
launched automatically in Initial Mode after the CAD service installation finishes. You 
can run the utility again later in Update Mode to change your configuration settings. To 
run the utility in Update Mode, choose one of the following methods:

■ launch the utility from Desktop Administrator

■ run PostInstall.exe, which is located on each CAD computer in C:\Program 
Files\Cisco\Desktop\bin

The windows that appear when you run this utility depend on the following factors:

■ the host computer on which the Configuration Setup utility was launched

■ the mode in which the Configuration Setup utility is running

■ the services and applications that are running on the computer on which the 
Configuration Setup utility was launched

Table 2 lists all of the windows that are part of the Configuration Setup utility in 
alphabetical order. For each window, the table indicates whether that window appears 
when the utility is run on the computer that hosts the named application or service. If 
you need to change a configuration setting, use the table to determine the computer 
on which you must run the Configuration Setup utility. The table has the following 
columns:

■ Window title: The name of the window

■ Mode: The mode in which the window appears (Update or Both initial/update)

■ Base: The computer on which the CAD base services run

■ VoIP: The computer on which the VoIP Monitor Service runs

■ Rec: The computer on which the Recording and Statistics Service runs

■ CAD/CSD: The computer on which Cisco Agent Desktop and Cisco Supervisor 
Desktop run

■ CDA: The computer on which Cisco Desktop Administrator runs

Table 2. CAD Configuration Setup windows

Window Title Mode Base VoIP Rec
CAD 
CSD CDA

CAD-BE Servers Update ×

CallManager Both × × ×
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To modify CAD configuration settings:

1. Start CAD Configuration Setup. 

■ In Desktop Administrator, select the logical contact center node in the left 
pane and then choose Setup > Configure Systems from the menu bar.

■ On another CAD host computer, navigate to the …\Program 
Files\Cisco\Desktop\bin folder and double-click PostInstall.exe.

CAD Configuration Setup starts and displays the CAD Directory Services 
dialog box.

CallManager SOAP AXL Access Both × × ×

CTI OS Both × ×

CTI OS Security Setup Both ×

CTI Server (CallManager) Both × ×

ICM Admin Workstation Database Both ×

ICM Admin Workstation Distributor Both ×

Recording and Statistics Service Database Both ×

Replication Setup Both ×

Restore Backup Data Both ×

Services Configuration Update × × ×

SNMP Configuration Update × × ×

Terminal Services Both ×

VoIP Monitor Service Update x × ×

Table 2. CAD Configuration Setup windows

Window Title Mode Base VoIP Rec
CAD 
CSD CDA
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Figure 3. Cisco Agent Desktop Directory Services dialog box.

2. Ensure that the correct primary (and optional secondary) Directory Services IP 
addresses are entered, and then click OK.

The Cisco Agent Desktop Configuration Setup tool is displayed with the 
CallManager node selected.

NOTE:  You can press F6 to switch between the left and right pane, 
and the up and down arrows to move up and down the navigation tree 
in the left pane.

3. Select the node you want to modify from the left pane, enter the new data in 
the right pane, and then click Apply.

■ You can display the nodes in any order you wish.

■ If you modify something in a node, you must click Apply to save your 
changes before you move on to another node.

4. When you are done making your changes, choose File > Exit or click Close.

CAD Configuration Setup closes.

5. Stop and restart the CAD services and all desktops for the change to go into 
effect.

Configuration Setup Windows

The following pages describe all of the windows in the CAD Configuration Setup utility. 
The windows are described in alphabetical order. 
June 2007 33



Cisco Desktop Administrator User Guide
CAD-BE Servers

Figure 4. CAD-BE Servers window.

The CAD-BE Servers window only appears during Update mode.

Enter the hostname or IP address of the CAD Base Services servers. This is where the 
Tomcat webserver required to run CAD-BE is installed. 

If you have agents outside your firewall, use the external hostname or IP address that 
maps to the primary and secondary CAD Base Services servers. If all agents are inside 
your firewall, use the internal hostname or IP address.

■ If you have only one instance of the CAD Base Services, enter the information 
in the Primary section.

■ If you are also using a secondary instance of the CAD Base Services and have 
configured replication, enter its location in the Secondary section.

NOTE:  The Secondary section is not enabled until the secondary CAD 
Base Services are set up and replication is configured.

NOTE:  If you set up replication during initial mode, the Secondary 
Location will be filled automatically.
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CallManager

Figure 5. CallManager window.

The CallManager window has two sections: the Publisher section and the Subscriber 
section. If you have only one CallManager, complete the Publisher section and leave 
the Subscriber section blank. If you have a CallManager cluster, which consists of one 
publisher CallManager and one or more subscriber CallManagers, complete both 
sections.

For the Publisher section, select Hostname or IP Address. Then type the location of 
the CallManager (the publisher CallManager if you have a CallManager cluster). 

If you have a single CallManager, leave the Subscriber section blank and click Apply.

If you have a CallManager cluster, add the locations of all of the subscriber 
CallManagers in the Subscribers section. To add a subscriber location, click Add. The 
Add/Edit Host dialog box appears. Enter the location of the subscriber CallManager in 
one of the following ways, then click Apply.

■ Select Hostname, then type the hostname of the subscriber CallManager.

■ Select Hostname, then choose the hostname of the subscriber CallManager 
from the drop-down list.

■ Select IP Address, then type the IP address of the subscriber CallManager.

NOTE:  If you change these settings after initial setup, you must 
restart the Sync Service and the VoIP Monitor Service to ensure that 
the change is registered with them properly.
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CallManager SOAP AXL Access

Figure 6. CallManager SOAP AXL Access window.

Enter the login ID and password required for the Publisher CallManager 
Administration to access SOAP AXL (Simple Object Access Protocol Administrative XML 
Layer), and select the CallManager version.

The login ID and password are the same used to access the Publisher CallManager.

NOTE:  If you change these settings after initial setup, you must 
restart the Sync Service and the VoIP Monitor Service to ensure that 
the change is registered with them properly. 
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CTI OS

Figure 7. CTI OS window.

Enter the hostname or IP address, port number, and peripheral ID of the CTI OS 
(Computer Telephony Integration Object Server).

■ If you have only one CTI OS, enter the information in the CTI OS A section.

■ If you are also using a redundant CTI OS in a duplexed environment, enter the 
location of the redundant CTI OS in the CTI OS B section.

If you are running CAD Configuration Setup in Upgrade mode, the question Is the 
CTI OS Security Setting Enabled appears. Select Yes or No.

NOTE:  If you are running CAD Configuration Setup in Initial mode 
(immediately after installation), the question Is the CTI OS Security 
Setting Enabled does not appear.

If you choose Yes, ensure that CTI OS security is enabled on the CTI OS server. Then, 
follow the procedures in “Setting Up CTI OS Security” in Cisco CAD Installation Guide.
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CTI OS Security Setup

Figure 8. CTI OS Security Setup window.

Click Launch to start the Cisco CTI OS Security Setup installation program and install 
the CTI OS Security client on the PC.

This window appears only if CTI OS Security is enabled for your system.

For more information, see “Setting Up CTI OS Security” in Cisco CAD Installation 
Guide.
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CTI Server (CallManager)

Figure 9. CTI Server (CallManager) window.

Enter the hostname or IP address, port number, and peripheral ID of the ICM CTI 
Server associated with the CallManager or CallManager cluster.

■ If the CTI Server is entered with a hostname in ICM, enter a hostname. If it is 
entered as an IP address, enter an IP address. Mixing hostname and IP 
address between the ICM and Configuration Setup can result in failing to 
display enterprise data in desktop applications.

■ If you have only one ICM CTI server, enter the information in the Side A 
section.

■ If you are also using a redundant ICM CTI server in a duplexed environment, 
enter the location of the redundant ICM CTI server in the Side B section.

■ The peripheral ID is used by services to filter information such as agents and 
skills. You can find the peripheral ID by using PG Explorer in the ICM 
Configuration Manager.

NOTE:  If you change the peripheral ID, you must restart the Sync 
Service, the Enterprise Service, and the Browser and IP Phone Agent 
Service to ensure that the change is registered with them properly.

NOTE:  If you are running System IPCC and change the Peripheral ID, 
your system will not work.
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ICM Admin Workstation Database 

Figure 10. ICM Admin Workstation Database window.

The ICM Admin Workstation database locations are autofilled based on what you 
entered in the ICM Admin Workstation Distributor window. 

Select the database type, SQL or NT, then type the instance name and a user 
login ID/password. The user must have read privileges for the ICM Admin Workstation 
database.

■ If you select NT, the user must also have an account on the ICM Admin 
Workstation computer. Use the format <domain>\<username> or 
.\<username> for the login ID.

Select the connection type, TCP/IP or Named Pipes.

■ If TCP/IP, type the port number used to connect to the database.

■ If Named Pipes, type the share path in the format \\<path> in the Port field.

NOTE:  If you change these settings after initial setup, you must 
restart each Recording and Statistics Service and the Sync Service to 
ensure that the change is registered with them properly.
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ICM Admin Workstation Distributor

Figure 11. ICM Admin Workstation Distributor window.

Type the hostname or IP address of the ICM Admin Workstation (AW) Distributor. 

■ If you have only one ICM AW Distributor, complete the Primary section only.

■ If you are using a secondary ICM AW Distributor, type its location in the 
Secondary section.

NOTE:  If you change either location after initial setup, you must 
restart each Recording and Statistics Service and the Sync Service to 
ensure that the change is registered with them properly. 

If you are running CAD Configuration Setup in Update mode, the Dynamic Reskilling 
and System IPCC Environment sections appear. 

■ Dynamic Reskilling: To enable supervisors to dynamically re-skill agents on 
their teams using the Cisco Unified Contact Center Enterprise Web 
Administration Agent Re-skilling tool, check Enabled. This tool is a web-based 
application. If it is located on a secured server and requires a secure socket 
URL (https), select the Secured client connection check box. If you leave this 
box unchecked, the URL will use the http prefix.

■ System IPCC Environment: Select Yes or No to indicate whether or not your 
configuration is running in a System IPCC environment.
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If you are running CAD Configuration Setup in Initial mode (immediately after 
installation), the Dynamic Reskilling and System IPCC Environment sections do not 
appear in the ICM Admin Workstation Distributor window.

NOTE:  If Configuration Setup does not detect that it is installed in a 
System IPCC Environment, a dialog box will appear during Initial 
mode, prompting you to indicate whether it is a System IPCC 
Environment.

Recording and Statistics Service Database 

Figure 12. Recording and Statistics Service Database window.

This window is displayed if you are running CAD Configuration Setup in both Initial and 
Update modes. If you are running CAD Configuration Setup on the secondary server in 
a replicated system, this window does not appear, because the database information 
was already entered on the primary system.

NOTE:  If you change these settings after initial setup, you must 
restart each Recording and Statistics Service to ensure that the 
change is registered with them properly.

In the Database Population Method section, select the method you want to use to set 
up the Recording and Statistics Service database.

■ Select Blank Database (the default) when installing a single service or a 
primary service in a replicated environment. This option creates the Recording 
and Statistics Service schema.
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■ Select Restore From if you are restoring a previously backed-up database. If 
you are running CAD in a replicated environment, a dialog box appears, 
reminding you to shut down replication before restoring data. After dismissing 
the dialog box, use the Browse button to navigate to the location of the 
backup database created using the BackupDB and CDBRTool utilities. 

When you continue to the next window, a dialog box appears, reminding you to 
re-establish replication after the restore is done.

NOTE:  You can restore recording metadata without restoring audio 
files, but you cannot restore audio files without recording metadata. 

For information about backing up and restoring CAD data, see "Backup and Restore 
(BARS)" in Cisco CAD Installation Guide.

Replication Setup

Figure 13. Replication Setup window.

This window is displayed only when you run CAD Configuration Setup in Update mode 
on the secondary CAD Services server.

Use the Replication Setup window to add a secondary Directory Services, a secondary 
Recording and Statistics Service, or both, after the initial system setup. The primary 
service will then replicate data on the secondary service so that they both contain 
identical information.

NOTE:  If you are setting up replication for the Directory Services 
and/or the Recording and Statistics Service, make sure that Cisco 
Security Agent is stopped on both computers.
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If you want to set up Directory Services replication, select On for Directory Services 
Replication. If you want to set up Recording and Statistics replication, select On for 
Recording and Statistics Replication. If you select On for one or both services, type the 
IP addresses of the primary and secondary servers in the corresponding fields.

To save your settings, click Apply. A dialog box appears and prompts you to type the 
hostname of the computer you have identified as the primary server for Recording and 
Statistics replication. Type the primary server hostname and click OK. A dialog box 
appears and prompts you to type the hostname of the computer you have identified as 
the secondary server for Recording and Statistics replication. Type the second server 
hostname and click OK.

Restore Backup Data

Figure 14. Restore Backup Data window.

This window appears only when CAD Configuration Setup is run for the first time 
during CAD services installation. 

If you want to restore data that was saved from a previous version of CAD, click Yes. A 
dialog box appears, reminding you to shut down replication before you start restoring 
backup data. 

NOTE:  If you do not shut down replication before restoring your data, 
your database may become corrupted.

Click OK and then enter the path to the backup folder. When you move to the next 
window or click Apply, a dialog box appears, reminding you to re-establish replication 
after you exit CAD Configuration Setup.
44 June 2007



CAD Configuration Setup Utility
The tool used to save data is CDBRTool utility, used to back up data from CAD 6.0 and 
CAD 7.0.

For information about using these tools, see "Upgrading From a Previous Version" in 
Cisco CAD Installation Guide.

Services Configuration

Figure 15. Services Configuration window.

The Services Configuration window only appears during Update mode.

If the computer has more than one IP address, select the IP address of the NIC used 
to connect to the LAN—it must be accessible by the client desktops.

If you enable automated CAD updates, every time a user starts Agent Desktop, 
Supervisor Desktop, or Desktop Administrator the system checks if there is a newer 
version available. if there is, it automatically runs the update process. 

To enable automated updates, select Yes.

NOTE:  Automated updates are disabled for Windows Vista.

In order to connect to the CallManager, the BIPPA Service must have a user ID and 
password. This user ID and password are also set up in CallManager. You can 
complete these fields before actually setting up the user in CallManager, but the user 
ID and password must be identical in both places. If they are changed in this window 
or in CallManager, they must be changed in both.
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NOTE:  If you change these settings after initial setup, you must 
restart the all CAD services to ensure that the change is registered 
with them properly.

To set up the user ID and password, see "Creating a CallManager User" in Cisco CAD 
Installation Guide.

SNMP Configuration

Figure 16. SNMP Configuration window.

The SNMP Configuration window appears only during the Update mode if the 
Microsoft Simple Network Management Protocol (SNMP) Service is installed on the 
CAD services server. 

If you select the Enable SNMP Trap Generation check box, INFO and higher error 
messages are sent from the CAD services server to the IP addresses configured in the 
Destination pane. Use the Add, Edit, and Remove buttons to manage the list of 
destination IP addresses.

The SNMP Service can be installed using the Add/Remove Windows Components 
button in the Add or Remove Programs utility in Control Panel (select Management 
and Monitoring Tools from the list of available components, and then choose Simple 
Network Management Protocol). 
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SNMP allows you to monitor and manage a network from a single workstation or 
several workstations, called SNMP managers. SNMP is actually a family of 
specifications that provide a means for collecting network management data from the 
devices residing in a network. It also provides a method for those devices to report any 
problems they are experiencing to the management station.

Consult Microsoft SNMP documentation for more information on using this tool.

Terminal Services 

Figure 17. Terminal Services window.

If this installation of Cisco Agent Desktop is installed in a Microsoft Terminal Services 
or Citrix environment, click Yes. If not, click No.

NOTE:  You must be running CAD Configuration Setup on the PC 
where the Citrix/Microsoft Terminal Services Service is hosted in 
order to view this window. 
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VoIP Monitor Service 

Figure 18. VoIP Monitor Service window.

The VoIP Monitor Service window only appears during Update mode.

Select the IP address of the network adaptor to which voice packets are sent to be 
sniffed by the VoIP Monitor Service (if this is a server box) or the desktop monitor (if 
this is a client desktop). 

■ On a VoIP Monitor Service server, it is the IP address of the NIC that is 
connected to the port configured for SPAN. 

■ On a client desktop computer, it is the IP address of the NIC on which the 
computer is daisy-chained to the phone.

NOTE:  If you change these settings after initial setup, you must 
restart the VoIP Monitor Service or the client application (depending 
on where you run Configuration Setup) to ensure that the change is 
registered with them properly.
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Synchronizing Directory Services

The Directory Services database should by synchronized with the master ICM agent 
database. You can synchronize the agent database between the ICM software and 
Directory Services with the Synchronize Directory Services command.

By default, the database is synchronized once every 10 minutes. You can change the 
synchronization interval by changing a setting in the DirAccessSynSvr.cfg file (refer to 
Cisco CAD Service Information, Chapter 3), or you can synchronize the databases 
manually.

To synchronize the databases manually:

1. In the left pane, select the logical contact center node.

2. Choose Setup > Synchronize Directory Services.

When the synchronization is complete, the system displays a confirmation 
message (see Figure 19).

Figure 19. Directory Services synchronization confirmation.
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Enterprise Configuration
Introduction

Enterprise Configuration enables you to:

■ Set up and modify enterprise data layouts and fields

■ Assign phones to be monitored by a particular Voice over IP (VoIP) Monitor 
service

■ Configure devices for desktop monitoring

To use either Enterprise Configuration application, select the Enterprise Data node or 
VoIP Monitor node in the left navigation pane of the Desktop Administrator window.
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Enterprise Data

Enterprise data is information associated with an incoming call. It is displayed in Cisco 
Agent Desktop, Cisco Agent Desktop—Browser Edition, and Cisco IP Phone Agent (see 
Figure 20).

Figure 20. Enterprise data as it appears in the CAD client applications. All applications are using 
the same default layout.

Cisco Agent Desktop

Cisco Agent Desktop—Browser Edition

Cisco IP Phone Agent 
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Use the Desktop Administrator’s Enterprise Data window to specify what information 
is displayed and how it appears in the agent applications.

NOTE:  The agent applications must be restarted for any enterprise 
data variable or layout changes you make to go into effect.

When you select Enterprise Data in the navigation pane, the display pane displays the 
Field List and Layout List (see Figure 21).

Figure 21. The Enterprise Data window.

Fields

The Field List displays both the predefined fields in ICM and the custom fields you 
create using the Field Editor.

■ Predefined fields have index numbers of 159–255, and cannot be edited.

■ Custom fields have index numbers of 0–158, and can be edited.

■ Fields marked with an asterisk (*) are expanded call context (ECC) variables. 
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To add a custom field to the Field List:

1. In the Field List area, click Add.

The Field Editor dialog box appears (see Figure 22).

Figure 22. The Field Editor dialog box.

2. Choose a field index number from the drop-down list. 

The field automatically shows the next available number.

3. Enter a field name that describes the contents of the field. 

The field name and field value can contain only the following characters:

■ Alphanumeric characters (Aa–Zz, 0–9)

■ Underscore ( _ )

■ Period ( . )

If you use disallowed characters in the field name or field value, they may not 
display in the IP Phone Agent service.

NOTE:  For Chinese, Japanese, and Korean localized sites, 
IP Phone Agent phones display the field index number, not 
the field name. This is due to phone limitations on displaying 
multi-byte characters. 

If the field is an ECC variable, the field name must exactly mirror how the field 
is expressed in ICM, but without the “user” prefix. For instance, the ICM ECC 
variable user.Account.Number must be named .Account.Number in the 
custom field list.
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NOTE:  ECC variable names cannot be localized with 
multi-byte characters due to a limitation in ICM. 

4. If the field is an ECC variable, select the appropriate check box—Scalar or 
Array.

■ A scalar ECC variable is one that stores a single piece of data.

■ An array ECC variable is one that stores multiple pieces of data.

5. If you select Array, specify the number of elements in the array in the number 
field on the right. 

Entering a number in the number field disables the Field Index field. The 
system automatically assigns the next available indexes to each element in 
the array.

6. Click OK.

The Field Editor dialog box closes.

7. In the Enterprise Data window, click Apply to save your changes.

To edit an existing custom field:

1. In the field list, select the field you want to edit, and then click Edit.

The Field Editor dialog box appears.

2. Make your changes, and then click OK.

The Field Editor dialog box closes.

3. In the Enterprise Data window, click Apply to save your changes.

To delete a custom field:

1. In the field list, select the field you want to delete, and then click Delete.

You can delete only custom fields.

2. In the Enterprise Data window, click Apply to save your changes.

Layouts

The Layout List displays the field layouts available for use on the agent desktop. Each 
layout may contain up to 16 fields chosen from the fields in the Field List. You can 
create up to 15 custom layouts in addition to the default layout, for a maximum 
number of 16 layouts. 

You cannot delete the default layout, but it can be edited to add or remove enterprise 
data fields. 
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NOTE:  Cisco Unified CCE Outbound Dialer enterprise data fields 
(fields prefixed with “BA”) display correctly only when added to the 
Default layout. For more information on Outbound Dialer enterprise 
data fields, see "Outbound Dialer Enterprise Data" on page 161. 

To create a custom layout:

1. In the Layout List area, click Add.

The Layout Editor dialog box appears (see Figure 23).

Figure 23. The Layout Editor dialog box.

2. In the Layout Name field, enter a name for your layout. 

3. Select the desired field from the available fields in the right pane, and either 
click the left arrow button or double-click your selection to move it to the left 
pane. You may select up to 16 fields.

4. To rearrange the order in which fields are displayed in the left pane, select a 
field and click the up or down arrow button to move the field up or down in the 
list.

5. When the layout is arranged to your satisfaction, click OK.
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The Layout Editor dialog box closes.

6. In the Enterprise Data window, click Apply to save your changes.

To edit an existing layout:

1. In the Layout List, select the layout you want to edit, and then click Edit.

The Layout Editor dialog box appears.

2. Make your changes, and then click OK.

The Layout Editor dialog box closes.

3. In the Enterprise Data window, click Apply to save your changes.

To delete an existing layout:

1. In the Layout List, select the layout you want to delete, and then click Delete. 

The layout is deleted.

2. In the Enterprise Data window, click Apply to save your changes.

NOTE:  You cannot delete the Default layout.

Custom Layouts

If you want to use a custom layout rather than the default layout, you must first create 
the custom layout and then create a custom ICM script.

To use a custom layout:

1. Create a new ECC scalar variable with ICM Configuration Manager. The new 
variable stores the new layout as set in an ICM script.

2. Delete the existing field with the index number of 252 from the list of 
variables. 

3. Add a new custom field with an index number of 252. (This index number is 
an exception to the rule that fields with indexes between 231 and 255 are 
predefined and not editable.) 

4. Name the new field with the name you gave the new ECC variable you created 
in Step 1, without the “user” prefix. 

The new field must be a scalar variable, not an array variable. 

5. Create a new layout (see the procedure "To create a custom layout:" on page 
56). 

6. Write an ICM script that assigns the new layout name to the new ECC variable. 
See your ICM documentation for information on creating scripts. 
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VoIP Monitor

The VoIP Monitor window (Figure 24) enables you to:

■ Enable desktop monitoring or server monitoring for devices

■ Configure a default VoIP Monitor server for server monitoring

■ Configure devices to be monitored by specific VoIP Monitor servers

■ Configure agent gateways to be monitored by specific VoIP Monitor servers in 
order to monitor and record mobile agents

The default setting is all agents using desktop monitoring. In general, there is no need 
to configure devices for VoIP Monitor server monitoring. See "VoIP Monitor Service 
Monitoring" on page 60 for more information.

Desktop monitoring and server monitoring are two ways of providing CAD-based 
monitoring. If your system configuration uses Cisco Unified Communications 
Manager 6.0 (Unified CM), CAD also supports Unified CM-based monitoring. 

The type of monitoring that is used is determined when the Cisco components of your 
system are installed. CAD uses either Unified CM-based or CAD-based monitoring, not 
both. If your system is configured to use Unified CM-based monitoring, desktop and 
server monitoring are not available.

NOTE:  If your system is configured to use Cisco Unified 
Communications Manager-based (Unified CM-based) silent 
monitoring, no additional configuration is required in Desktop 
Administrator. 
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Figure 24. The VoIP Monitor window (VoIP Monitor Services tab).

Desktop Monitoring

A phone is monitored either through desktop monitoring or a VoIP Monitor service—it 
cannot be monitored by both. However, a VoIP Monitor service can be a backup if the 
agent’s desktop monitoring module fails to register with Directory Services when CAD 
is started. 

With desktop monitoring enabled, software on the agent desktop handles recording 
and monitoring requests for that agent. This is possible only on desktops that are 
physically connected to the network through a hard IP phone (see the Cisco CAD 
Installation Guide for a list of supported hard IP phones) or through the Cisco IP 
Communicator soft phone. Desktop Monitoring does not apply to agents using the IP 
Phone Agent service on their IP phone or to CAD-BE agents.

NOTE:  Desktop monitoring does not function with some NIC cards 
that are unable to detect both voice packets and data packets in a 
multiple VLAN environment. For more information on this issue, and 
suggested work-arounds, see Chapter 1 in the Cisco CAD Installation 
Guide.
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NOTE:  A number of factors can prevent desktop monitoring from 
registering with Directory Services when CAD is started—for example, 
there might be network connectivity issues, a lack of some system 
resources due to other applications running on the agent PC, or 
issues with the NIC card. As a result, the availability of desktop 
monitoring cannot be guaranteed.

Desktop monitoring is enabled by default.

To disable desktop monitoring:

■ On the VoIP Monitor Devices tab, clear the device’s Enable Desktop 
Monitoring check box.

VoIP Monitor Service Monitoring

If your system has only one VoIP Monitor service, it is not necessary to set a default 
monitor service or to manually assign each device to that single monitor. The VoIP 
Monitor service assumes that each device is assigned to it as the only available 
monitor service. 

This does not apply to devices that are configured to use desktop monitoring. The 
default VoIP Monitor service does serve as a backup for desktop monitoring if no other 
VoIP Monitor service is explicitly defined as the backup.

It is advisable to select a default monitor service to avoid the possibility of having 
devices unassigned to a monitor service. This situation can arise when there is more 
than one VoIP Monitor service in the system.

Modifications you make in the VoIP Monitor window are immediately written to LDAP 
and go into effect shortly thereafter.

Agents using the IP Phone Agent service and CAD-BE agents must be monitored via a 
VoIP Monitor service.

Devices Displayed in the VoIP Monitor Window

The VoIP Monitor Devices tab displays all agent devices set up in the Unified CM.

If a phone is configured for extension mobility, the Extension field displays:

■ the extension of the user logged into the phone via the Extension Mobility 
service

■ the static extension assigned to the device’s MAC address, if no user is logged 
into the phone and if a static extension is set up

■ a blank if no static extension is set up
60 June 2007



VoIP Monitor
NOTE:  We recommend you assign a static extension to an extension 
mobility device to make administration easier.

To set a default VoIP Monitor service:

■ On the VoIP Monitor Services tab, choose a VoIP Monitor service from the 
Default VoIP Monitor Server field. 

The service you choose is set as the default monitor service for your system. 
Any device not assigned to a specific VoIP Monitor service or that has desktop 
monitoring disabled is monitored by the default monitor service.

To assign a device to a specific VoIP Monitor service:

1. Select the VoIP Monitor Services tab.

2. Using either the device’s extension or the MAC address, locate the device you 
wish to assign to a specific VoIP Monitor service. 

You can click a column header to sort the column in ascending or descending 
order to make your search easier.

3. Choose a VoIP Monitor service from the Monitor Server drop-down list. 

You can right-click anywhere in a device’s row to pop up the Select a VoIP 
Monitor Server dialog box from which to choose a VoIP Monitor service.

4. Make sure that the device’s Enable Desktop Monitoring check box is cleared.

The device is now assigned to that VoIP Monitor service.

To assign multiple devices to a specific VoIP Monitor service:

1. Use standard Windows multiple selection techniques to assign more than one 
device to a specific VoIP Monitor service:

■ Shift-Click to select a range of contiguous devices, then right-click the 
selected devices to display the Select a VoIP Monitor Server dialog box.

■ Ctrl-Click to select non-contiguous devices, then right-click the selected 
devices to display the Select a VoIP Monitor Server dialog box.

2. Choose the VoIP Monitor service from the drop-down list.

The devices you selected are now assigned to that VoIP Monitor service.

Mobile Agent Monitoring

Mobile agents can connect to the system through any one of a number of agent 
gateways. The Mobile Agent Monitor tab (see Figure 25) enables you to assign one 
VoIP Monitor service to each agent gateway. Only one VoIP Monitor service per agent 
gateway is supported. One VoIP Monitor service can be assigned to multiple agent 
gateways as well as to regular agent phones.
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For mobile agent monitoring to work, the caller and agent voice gateways must be 
separate. In addition, the VoIP Monitor server must be located in the network where it 
can see the traffic flowing between the agents and customers. If the customer and 
agent are speaking to each other over the same voice gateway, then that voice stream 
will remain local to the gateway and not be exposed to the VoIP Monitor Service. SPAN 
will not send those packets to the VoIP Monitor Service, and the conversation will not 
be heard. For this reason, monitoring and recording of Agent-to-Agent calls is not 
supported.

One additional limitation of mobile agent monitoring is that if a mobile agent logs in 
while on a call or is on a call during a CAD services or CRI server failover, the agent 
cannot be monitored until the call state changes or the agent makes a new call.

Figure 25. Mobile Agent Monitor tab.

To set up mobile agent monitoring:

1. On the Mobile Agent Monitor tab, double-click or right-click the first available 
field in the Agent Gateway IP Address column.

2. Enter the IP address of the agent gateway to be monitored.

3. In the Monitor Server field, select the VoIP Monitor service that will monitor 
the agent gateway from the drop-down list.
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Your changes go into effect immediately.

Effect of Monitoring Options on Devices

Use Table 3 to determine the effect on monitored devices with various combinations 
of desktop monitoring, VoIP Monitor service monitoring, and setting a default monitor.

If a device is assigned to be monitored by a specific VoIP Monitor service, and that 
service fails, there is no failover to the default VoIP Monitor service (if one is 
designated). However, if a device has desktop monitoring enabled, and the desktop 
monitoring module is not registered with Directory Services at the time a monitoring or 
recording session is requested, there is failover to a specific VoIP Monitor service (if 
designated) or to the default VoIP Monitor service (if designated).

Table 3. Effect of Monitoring Options on Devices 
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Effect on Devices

No No No
Monitoring fails if there are multiple VoIP monitor services; 
monitored by default VoIP Monitor service if there is one 
VoIP Monitor service in the system.

Yes No No Monitored by specific VoIP Monitor service; no backup in 
case of failure.

Yes Yes No Monitored by Desktop Monitor; backed up by specific VoIP 
Monitor service.

Yes No Yes Monitored by specific VoIP Monitor service; no backup in 
case of failure.

No Yes No
Monitored by Desktop Monitor; no backup in case of failure. 
If there is only one VoIP Monitor service in the system, it 
serves as backup.

No Yes Yes Monitored by Desktop Monitor; backed up by default VoIP 
Monitor service.

No No Yes Monitored by default VoIP Monitor service; no backup in 
case of failure.

Yes Yes Yes
Monitored by Desktop Monitor; backed up by the specific 
VoIP Monitor service. If the selected VoIP Monitor service 
fails, there is no backup.
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Removing a VoIP Monitor or Recording & Playback 
Service from Directory Services

You can remove a VoIP Monitor service or Recording & Playback service from Directory 
Services.

Remove these services only if you intend to uninstall (or already have uninstalled) the 
VoIP Monitor service or Recording & Playback service permanently. The Remove 
function enables you to clean up Directory Services.

NOTE:  Removing a VoIP Monitor service can result in devices 
becoming unmonitored.

To remove a VoIP Monitor or Recording & Playback service from  
Directory Services:

1. From the menu bar, choose Edit > Remove Services, or click the Remove VoIP, 
Recording/Playback Services button on the toolbar.

The Remove VoIP/Recording & Playback Server dialog box is displayed (see 
Figure 26). 

Figure 26. The Remove VoIP/Recording & Playback Server dialog box.

2. From the appropriate drop-down list, select the service you want to remove 
from Directory Services. 

3. Click the Remove button next to the selected service. 

The selected service is removed from Directory Services.

4. Click Close to close the dialog box.

To restore a removed service to Directory Services:

1. Stop and then restart the removed service from the Windows Services dialog 
box.

2. Stop and then restart Desktop Administrator.
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The service is restored to the list of available services.
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Work Flow Configuration
Introduction

Work Flow Configuration enables you to configure and maintain the appearance and 
behavior of Agent Desktop, CAD-BE, and IP Phone Agent. Work Flow Configuration has 
6 functions:

■ Dial Strings (page 69)

■ Phone Books (page 78)

■ Reason Codes (page 82)

■ Wrap-up Data (page 86)

■ Record/Monitor Notification (page 91)

■ Work Flow Groups (page 92)

To use any Work Flow Configuration application, select its node in the left navigation 
pane of the Desktop Administrator window (see Figure 27). The right display pane 
shows the selected node.
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Figure 27. The Work Flow Configuration window (Dial Strings node selected).
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Dial Strings

Use the Dial Strings function to configure the way desktop applications display and 
dial phone numbers.

NOTE:  Dial strings for CAD-BE are not configurable.

Select the appropriate check box at the bottom of the Dial Strings pane to choose the 
dial string format you will use. The available formats are: 

■ North American Dial String Format

■ Variable Length Dial String Format

Different tabs display depending on your choice.

North American Dial String Format

If you choose the North American dial string format, the following three tabs are 
active:

Telephone Number Display

The Telephone Number Display tab (see Figure 28) enables you to configure how 
phone numbers are displayed in Agent Desktop. 

The selections you make are reflected in the sample fields. (An exception is if you 
enter a value in either of the “Remove first ‘n’ digits” and “Remove last ‘n’ digits” 
fields. In that case, the sample does not change.)

Figure 28. Telephone Number Display tab.
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To configure the telephone number display:

■ Select or clear the check boxes and radio buttons on the Telephone Number 
Display tab as desired, and then click Apply to save your changes.

Outgoing Calls

The Outgoing Calls tab (see Figure 29) enables you to configure your local area codes 
and exchanges.

Figure 29. Outgoing Calls tab.

Table 4. Telephone Number Display tab sections.

Tab Section Description

External number format Specify the calling number and called number phone 
numbers format

Area code/Exchange Specify the separator between the area code and 
exchange

Exchange/Subscriber 
code

Specify the separator between the exchange and the 
subscriber code

Internal number format Specify the internal phone numbers format. You may 
include an X (extension) and remove the leading or 
trailing digits (in the event that extension numbers are 
less than 4 digits long). 
70 June 2007



Dial Strings
To configure outgoing calls:

■ Enter information and select or clear the appropriate check boxes on the 
Outgoing Calls tab as desired, and then click Apply to save your changes.

Advanced Internal Dialing

The Advanced Internal Dialing tab (see Figure 30) enables you to configure more 
internal dialing options. Access it by clicking the Advanced Dialing button on the 
Outgoing Calls tab.

Table 5. Outgoing Calls tab sections.

Tab Section Description

Local area code Enter the local 3-digit area code. NOTE: If you must dial 
the area code for local calls, leave this field blank.

Advanced Dialing… Click to configure Advanced Internal Dialing and 
Advanced External Dialing. 

Prefixes • Local line access code. Enter the number required to 
access an outside local line

• Long distance line access code. The number 
required to access an outside long distance line

• Ensure a 1 on long distance calls. Check to 
automatically add a 1 at the beginning of a long 
distance phone number

• Use area code for toll calls within the area code. 
Check to automatically add the local area code to 
any calls dialed to numbers not included in the local 
exchange list.

• Use area code for local calls. Check to automatically 
add the local area code to any calls dialed to 
numbers included in the local exchange list.

Local exchanges Check All exchanges are local or click Add to build a list 
of exchanges for which it is NOT necessary to add a 1 
before dialing
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Figure 30. Advanced Internal Dialing tab.

Advanced External Dialing

The Advanced External Dialing tab (see Figure 31) enables you to configure more 
external dialing options. Access it by clicking the Advanced Dialing button on the 
Outgoing Calls tab.

Table 6. Advanced Internal Dialing tab sections.

Tab Section Description

Extensions The maximum number of digits in an internal extension 
number, from 1–12. If you select 7, you must specify the 
internal exchange and the corresponding range of 
subscriber numbers so the application can distinguish 
between a 7-digit internal phone number and a 7-digit 
outgoing call.

7-digit extensions If you specified a 7-digit extension number, enter the 
internal exchange and the corresponding range of 
extension numbers from low to high. Click Add to add 
them to the list.
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Figure 31. Advanced External Dialing tab.

Miscellaneous

The Miscellaneous tab (Figure 32) sets up further dialing properties. 

NOTE:  This tab is the same for the North American and variable 
length dial string formats.

Table 7. Advanced External Dialing tab sections.

Window Section Description

Neighboring area codes 
with local dialing 
privileges

The area codes to which you can place non-toll calls. 
Click Add to add a new area code to the list and click 
Delete to remove an area code from the list.

Exchanges for 7-digit 
local numbers

Choose the neighboring area code, then enter the 
exchanges within that area code which do not require 
you to dial 1 or the area code. Check All exchanges as 
7-digit numbers if no exchange requires you to dial 1 or 
an area code.

Exchanges for 10-digit 
local numbers

Choose the neighboring area code, then enter the 
exchanges within that area code that require you to dial 
the area code but not a 1. Check All exchanges as 
10-digit numbers if all exchanges require you to dial an 
area code but not a 1.
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Figure 32. Miscellaneous tab.

To configure the miscellaneous options:

■ Select or clear the appropriate check boxes on the Miscellaneous tab as 
desired, and then click Apply to save your changes.

Table 8. Miscellaneous tab sections.

Tab Section Description

Use text from the 
clipboard as the phone 
number when pressing 
the call button

Check to enable Agent Desktop to use text on the 
clipboard as the dialed number when the Call button is 
pressed, as long as the text on the clipboard is a valid 
text string.

Show the dial pad when 
using text from the 
clipboard for dialing.

Available only if “Use text from the clipboard…” is 
enabled. Check to display the dial pad before dialing a 
number copied from the clipboard. If this box is not 
checked, Agent Desktop dials the number without 
displaying the dial pad.

Convert text to digits in 
phone numbers

Converts phone numbers expressed in alpha characters 
(for example, 1-800-ANYWORD) to their numeric 
equivalents before dialing.
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Variable Length Dial String Format

If you choose the variable length dial string format, the following three tabs are active:

Telephone Number Display

The Telephone Number Display tab (see Figure 33) enables you to configure how 
phone numbers are displayed in Agent Desktop. 

The selections you make are reflected in the Sample fields. (An exception is if you 
enter a value in either of the “Remove first ‘n’ digits” and “Remove last ‘n’ digits” 
fields. In that case, the sample does not change.)

NOTE:  The number of digits displayed in each section of the sample 
phone number is for illustration only. The samples do not reflect the 
number format you set up on the Phone Number Format tab.

Figure 33. Telephone Number Display tab.

Table 9. Telephone Number Display tab sections 

Tab Section Description

External number format Specify how you want to view the calling number and 
called number phone numbers.
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To configure the telephone number display:

■ Enter data and select or clear the appropriate check boxes and radio buttons 
on the Telephone Number Display tab as desired, and then click Apply to save 
your changes.

Phone Number Format

The Phone Number Format tab (Figure 34) enables you to establish the format for 
phone numbers that do not follow the North American dial string format. You can also 
set the maximum number of digits in an internal phone extension.

You can establish as many formats as you want, as long as each one has a unique 
total length. 

Figure 34. Phone Number Format tab.

City/subscriber code Specify the separator you want to display between the 
city code and the subscriber code.

Internal number format Specify how internal phone numbers are displayed. You 
may include an X (extension) and remove the leading or 
trailing digits (in the event that extension numbers are 
less than 4 digits long).

Table 9. Telephone Number Display tab sections — <Emphasis>Continued

Tab Section Description
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To add a new phone number format:

1. Click Add. 

The Add City/Subscriber Code Lengths dialog box appears.

2. Enter the number of digits in the city code and the subscriber code, and then 
click OK. 

The numbers you entered are displayed in the phone number format pane, 
along with the calculated total length of the format. You cannot enter another 
format with the same total length.

3. Click Apply.

The new phone number format is saved.

To edit a phone number format:

1. Choose the number format, and then click Edit.

The Edit City/Subscriber Code Lengths dialog box appears.

2. Make your changes, and then click OK.

3. Click Apply to save your changes.

The phone number format is changed.

To delete a phone number format:

1. Choose the number format, and then click Delete.

2. Click Apply to save your changes.

The phone number format is deleted.

Miscellaneous

The Miscellaneous tab for the variable length dial string format is the same as the tab 
for the North American dial string format. 

See "Miscellaneous" on page 73 for a description of the Miscellaneous tab.
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Phone Books

Agents have several lists of phone numbers available to them:

■ The Recent Call List, a dynamic list of up to 100 recently called phone 
numbers kept by Agent Desktop

■ A personal phone book with unlimited entries, created and maintained by the 
agent (and enabled/disabled by the system administrator)

■ Up to 256 global phone books, each with unlimited entries, created by the 
system administrator with the global Phone Book function

■ Work flow group phone books, created by the system administrator with the 
work flow group Phone Book function

Global phone books are created and maintained using the Phone Book node under 
the Work Flow Configuration node. Work flow group phone books are created and 
maintained using the Phone Book node under the specific work flow group’s node 
(see Figure 35).

Figure 35. Global and work flow phone book nodes.

The global Phone Book window (see Figure 36, left) enables you to set up and manage 
the global phone books that are shared by all agents, and to disable all phone books 
or just personal phone books. 

The work flow group Phone Book window (see Figure 36, right) enables you to set up 
and manage the work flow group phone books that are shared by agents in specific 
work flow groups. 

Global phone book node

Work flow group phone book node
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Phone books and phone book entries are created and maintained in the Phone Book 
Editor dialog box (see Figure 37).

Figure 36. Phone Book window.

The Phone Book Editor enables you to set up and maintain pone books.

Creating Phone Books

To set up a new phone book:

1. In the global or work flow group Phone Book window, click Edit.

The Phone Book Editor dialog box appears (see Figure 37).

Global level Work flow group level
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Figure 37. Phone Book Editor dialog box.

2. Enter a new phone book name in the Phone Books field, and then click Add.

The name of the new phone book is added to the list of phone books.

3. Click OK.

The new phone book is saved and the Phone Book Editor dialog box closes.

To add phone book entries:

1. In the Phone Book window, choose the phone book you want to edit from the 
drop-down list, and then click Edit.

The Phone Book Editor dialog box appears.

2. Enter a name, phone number, and note (optional) for a person or company, 
and then click Add to add the information to the phone book.

The Phone Number field allows only the characters 0–9, aA–zZ, ‘ ( ) + ; / : . = ? 
and a space. If you enter any other character you are advised you used a 
disallowed character. The disallowed character will be replaced by a question 
mark so you can change it to an allowed character.

3. Repeat Step 2 as needed to enter all entries to the phone book. When all 
entries are completed, click OK.

Your entries are saved and the Phone Book Editor dialog box closes.
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To edit phone book entries:

1. In the Phone Book window, choose the phone book you want to edit from the 
drop-down list, and then click Edit.

The Phone Book Editor dialog box appears.

2. Choose an entry in the phone book, and then take one of these actions:

■ Click Edit to modify the entry

■ Click Delete to delete the entry

3. When all edits are completed, click OK.

Your changes are saved and the Phone Book Editor dialog box closes.

Enabling or Disabling Phone Books

Phone books can be enabled or disabled only on the global level.

To enable or disable phone books:

1. In the global Phone Book window:

■ Select or clear the Disable all phone books check box to remove agent 
access to all global and work flow group phone books.

■ Select or clear the Disable personal phone book check box to remove 
access to all agents’ personal phone books.

2. Click Apply.
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Reason Codes

Reason codes describe why an agent has changed to the Not Ready agent state or 
has logged out. 

There is no limit on how many reason codes can be set up for CAD and CAD-BE. IP 
Phone Agent has a limit of 100 reason codes.

Reason codes are set up and maintained in ICM using the Cisco Unified Contact 
Center Enterprise Web Administration Tool (if you use System IPCC) or ICM 
Configuration Manager (if you use anything other than System IPCC, for example, ICM 
Enterprise/Hosted or Unified CC Enterprise/Hosted). You use Desktop Administrator to 
assign reason codes to agents on both a global and work flow group level.

Global reason codes are assigned using the Reason Codes node under the Work Flow 
Configuration node. Work flow group reason codes are assigned using the Reason 
Codes node under the specific work flow group’s node (see Figure 38).

Figure 38. Global and work flow reason code nodes.

Global reason codes are available for use by all agents. Work flow reason codes are 
available only to those agents in that specific work flow group. 

Reserved reason codes are predefined in LDAP and cannot be created or deleted. 
These reason codes are automatically applied to events over which agents have no 
control, such as being logged out by a supervisor or because of a system failure. They 

Global reason codes node

Work flow group reason codes node
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are not visible to the agent, but appear only in reports and in the global Reason Codes 
window. 

NOTE:  It is recommended that reason codes created in ICM do not 
use the same reason code numbers as the reserved reason codes. If 
there are duplicated reason code numbers, errors in reporting and 
other problems might result.

The reserved reason codes are:

Not Ready and Logout reason codes are enabled or disabled on the work flow group 
level.

NOTE:  You can configure reason codes within the Cisco Unified 
Contact Center Enterprise Web Administration Tool (if you use System 
IPCC) or the ICM Configuration Manager (if you use anything other 
than System IPCC) so that they are required when logging out or going 
to the Not Ready state. However, Agent Desktop cannot detect these 

Table 10. Reserved reason codes

Reason Code Description

-3 Extension modified while logged in

-2 PG failure

-1 Peripheral restarted

22 Supervisor logout

33 Supervisor not ready

20001 Not Ready for force logout

20002 Force logout

20003 Not Ready for logout

32767 Ring no answer

50001 CTI OS disconnect

50002 CTI OS component disconnect

50003 Device out of service

50004 Agent inactivity

50010 Routed call NOT delivered

50020 Agent Re-skill
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settings. It is recommended that the enterprise desk settings “Idle 
reason required” and “Logout reason required” be left unselected 
and that the enabling or disabling of reason codes be done within 
Desktop Administrator.

NOTE:  Agents must restart CAD, CAD-BE, and IP Phone Agent to see 
any changes you make to reason codes.

NOTE:  For Chinese, Japanese, and Korean localized sites, reason 
codes may not appear correctly in IP Phone Agent due to the phone 
limitations on multi-byte characters.

Figure 39. Reason Code window.

Assigning Reason Codes

To assign global reason codes:

1. Select the global Reason Codes node in the navigation tree to display the 
Reason Codes window (see Figure 39, left).

2. Select the appropriate tab for the type of reason codes you want to assign: 
Logout or Not Ready. 

3. From the Available Reason Codes List, select the reason codes you want 
available to all agents, and then click the right arrow button to move them to 
the Global Reason Codes List. 

4. Click Apply.

Global level Work flow group level
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To assign work flow reason codes:

1. Select the Reason Codes node under the desired work flow group in the 
navigation pane to display the Reason Codes window (see Figure 39, right).

2. Select the appropriate tab for the type of reason codes you want to assign, 
Logout or Not Ready. 

3. From the Available Reason Codes List, select the reason codes you want 
available to agents in that work flow group, and then click the right arrow 
button to move them to the Work Flow Group List. 

4. Select the Enable Logout Reason Codes or Enable Not Ready Reason Codes 
check box to enable that type of reason code for the agents in that work flow 
group. This includes any global reason codes set up.

5. Click Apply.

Enabling or Disabling Reason Codes

Reason codes can be enabled or disabled only on the work flow group level, and must 
be done individually for every work flow group.

To enable or disable reason codes:

1. Select the Reason Codes node under the work flow group whose reason 
codes you want to enable or disable.

2. Select the appropriate tab and then select or clear the Enable Logout Reason 
Codes or Enable Not Ready Reason Codes check box. 

3. Click Apply.
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Wrap-up Data

Wrap-up data descriptions are used by contact centers for purposes such as tracking 
the frequency of different activities and identifying the account to which to charge a 
call, among others. Wrap-up data is set up and maintained, and automated state 
changes are enabled, using the Wrap-up Data window.

There is no limit on how many wrap-up data descriptions can be set up for CAD and 
CAD-BE. IP Phone Agent has a limit of 100 wrap-up data descriptions.

NOTE:  CAD and CAD-BE agents must log out, exit, and restart the 
application for changes to take effect.

Global wrap-up data descriptions are created and assigned using the Wrap-up Data 
under the Work Flow Configuration node. Work flow group wrap-up data descriptions 
are created and assigned using the Wrap-up Data node under the specific work flow 
group’s node (see Figure 40).

Figure 40. Global and work flow wrap-up data nodes.

In Agent Desktop, CAD-BE, and IP Phone Agent, the agent selects the appropriate 
wrap-up data description at the beginning of the wrap-up work time for a call. The 
value the agent selects appears in the Termination_Call_Detail record for the call in 
the ICM database.

IP Phone Agent is limited to a maximum of 100 wrap-up data descriptions. 

Global wrap-up data node

Work flow group wrap-up data node
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To enable Desktop Administrator to properly manage wrap-up data, you must 
configure the following Enterprise Desk Settings options in ICM Configuration 
Manager as optional:

■ Work mode on Incoming

■ Work mode on Outgoing

Within ICM Configuration Manager, you can configure wrap-up data so that it is 
required when transitioning to the Work Ready or Work Not Ready states. However, 
Agent Desktop cannot detect these settings. Leave the ICM Configuration Manager 
settings as optional and enable or disable wrap-up data within Desktop Administrator.

When creating wrap-up data descriptions, follow these guidelines:

■ Descriptions may consist of up to 39 alphanumeric characters. No 
punctuation or other characters are allowed.

NOTE:  For Chinese, Japanese, and Korean localized sites, 
descriptions may not appear correctly in IP Phone Agent due to the 
phone limitations on multi-byte characters. 

■ Duplicate descriptions are not allowed.

Creating Wrap-up Data Descriptions

You can create and modify wrap-up data descriptions on both the global and work flow 
group level. 

To create a wrap-up data description:

1. Select the global or work flow group Wrap-up Codes node in the navigation 
tree to display the Wrap-up Codes window (see Figure 41).
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Figure 41. Wrap-up Data window.

2. Click Modify List to display the Wrap-up Data Editor dialog box (see Figure 42).

Figure 42. Wrap-up Data Editor dialog box.

3. Type the new wrap-up data description in the Description field, and then click 
Add.

The wrap-up data description is added to the Wrap-up Data list.

4. Click OK close the dialog box, and then click Apply to save your changes.

To edit a wrap-up data description:

1. Select the global or work flow group Wrap-up Data node in the navigation tree 
to display the Wrap-up Data window (see Figure 41).

2. Click Modify List to display the Wrap-up Data Editor dialog box (see Figure 42).

Global level Work flow group level
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3. Double-click the wrap-up data description you want to edit.

4. In the pop-up dialog box, edit the description as desired and then click OK.

5. Click OK to close the Wrap-up Data Editor dialog box, and then click Apply to 
save your changes.

To delete a wrap-up data description:

1. Select the global or work flow group Wrap-up Data node in the navigation tree 
to display the Wrap-up Data window (see Figure 41).

2. Click Modify List to display the Wrap-up Data Editor dialog box (see Figure 42).

3. Select the wrap-up data description you want to delete, and then click Delete.

4. Click OK to close the dialog box, and then click Apply to save your changes.

Assigning Wrap-up Data Descriptions

Wrap-up data descriptions can be assigned at the global and at the work flow group 
level. Global wrap-up data descriptions are available to all agents. Work flow group 
level wrap-up data descriptions are available only to the agents in that specific work 
flow group.

To assign global wrap-up data descriptions:

1. Select the global Wrap-up Data node in the navigation tree to display the 
Wrap-up Data window (see Figure 41, left).

2. From the Available Wrap-up Descriptions list, select the descriptions you want 
available to all agents, and then click the right arrow button to move them to 
the Global Wrap-up Descriptions list. 

3. Click Apply.

To assign work flow wrap-up data descriptions:

1. Select the Wrap-up Data node under the desired work flow group in the 
navigation pane to display the Wrap-up Data window (see Figure 41, right).

2. From the Available Wrap-up Data list, select the descriptions you want 
available to agents in that work flow group, and then click the right arrow 
button to move them to the Work Flow Wrap-up Data list. 

3. Select the Enable Wrap-up Data check box to enable wrap-up data for the 
agents in that work flow group. This includes any global wrap-up data 
descriptions set up.

4. Click Apply.
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Enabling or Disabling Wrap-up Data

Wrap-up data can be enabled or disabled only on the work flow group level.

To enable or disable wrap-up data:

1. Select the Wrap-up Data node under the work flow group whose wrap-up data 
descriptions you want to enable or disable.

2. Select or clear the Enable Wrap-up Data check box. 

3. Click Apply.

Automatic State Changes

If automatic state changes are enabled, agents are automatically changed from the 
Work Not Ready state to the Not Ready state, and from the Work Ready state to the 
Ready state, when they enter wrap-up data. 

Automatic state changes can be enabled or disabled only on the work flow group level.

NOTE:  It is possible to set a timer in ICM that will override the 
automatic state change. If an agent doesn’t enter wrap-up data within 
the time set by the timer, the system will change the agent’s state to 
the next state (Not Ready or Ready) and close the Wrap-up Data 
dialog box without anything being entered. 

To enable or disable automatic state changes:

1. Select the Wrap-up Data node under the work flow group whose automatic 
state changes you want to enable or disable.

2. Select or clear the Enable Automatic State Change check box. 

3. Click Apply.
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Record/Monitor Notification

The Record/Monitor Notification window is used at the global level to enable or 
disable messages to agents that they are being recorded or monitored, or both. 

Figure 43. Record/Monitor Notification window.

To enable or disable notification:

1. Select the Record/Monitor Notification node in the navigation tree.

2. In the Record/Monitor Notification window, select or clear the Notify 
Monitoring and/or Notify Recording check boxes, and then click Apply.

You can also enable/disable monitoring and recording from the menu bar. 

1. Select the Work Flow Configuration node or any of its subnodes in the 
navigation tree.

2. From the menu bar, choose Monitoring.

3. Choose Notify Monitoring and/or Notify Recording from the menu. A check 
mark appears next to the option when it is enabled. 
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Work Flow Groups

Use the Work Flow Groups function to create and configure agent work flow groups. 

Figure 44. Accessing Work Flow Group functions in the navigation tree.

Under the Work Flow Groups node are individual work flow groups. Initially there is a 
default work group, which can be edited, renamed, or deleted. You can also create 
additional work flow groups.

When you click on a work flow group, the elements that make up that work flow group 
appear as subnodes:

■ Enterprise Data. Configure enterprise data on the agent desktop for the 
selected work flow group.

■ Reason Codes. Assign reason codes for the selected work flow group.

■ Wrap-up Data. Create and edit wrap-up data for the selected work flow group. 

■ Phone Book. Create and edit phone books for the selected work flow group.

■ CAD Agent. Configure the user interface, voice contact work flows, and agent 
management work flows for agents using Cisco Agent Desktop.

■ CAD-BE Agent. Configure the user interface and voice contact work flows for 
agents using Cisco Agent Desktop Browser Edition.

■ IP Phone Agent. Enable agent-initiated recording for agents using the Cisco IP 
Phone Agent service.
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Maintaining Work Flow Groups

You can add, delete, or edit work flow groups under the Work Flow Groups node.

NOTE:  If you choose to delete the default work flow group, make sure 
that all agents are assigned to a custom work flow group you have set 
up. If an agent is not assigned to a work flow group, and there is no 
default work flow group, that agent will not be able to start Cisco 
Agent Desktop. 

To add a new work flow group:

1. In the Navigation tree, select the Work Flow Groups node.

2. Choose File > New, or click New on the toolbar.

The Work Flow Group Name Editor dialog box appears.

Figure 45. Work Flow Group Name Editor dialog box.

3. Enter a new work flow group name. 

If you want to copy an existing work flow group, select the Copy the following 
work flow group check box and choose a work flow group from the drop-down 
list.

4. Click OK.

The new work flow group appears in the Navigation pane under the Agents 
node.

To delete an existing work flow group:

1. In the Navigation pane, select the work flow group you want to delete.

2. Choose File > Delete, or click Delete on the toolbar.

You are warned that all agents belonging to the work flow group you want to 
delete must be reassigned to other work flow groups. Click Yes to confirm the 
deletion, or No to cancel it. 
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If you do not reassign the agents, you will not be able to delete the work flow 
group.

3. Click OK to close the dialog box.

You cannot rename an existing work flow group directly. Instead, you must set up a 
new work flow group and copy the existing work flow group’s settings to the new work 
flow group.

To rename a work flow group:

1. Add a new work flow group, giving it the name you want to change the existing 
work flow group’s name to.

2. Select the Copy the following work flow group check box and select the 
existing work flow group from the drop-down list, and then click OK. The copy 
process may take some time.

3. Delete the old work flow group.
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Enterprise Data

The Enterprise Data window enables you to: 

■ Configure Agent Desktop so that so that agents in the selected work flow 
group can edit enterprise data

■ Set thresholds for call duration at a particular type of device while a call is in 
the contact center

Data

The Data tab (see Figure 46) controls whether or not an agent in the work flow group 
is allowed to edit the enterprise data displayed in Agent Desktop. 

Figure 46. Data tab.

To enable enterprise data editing:

■ Select the Allow agent to edit Enterprise Data check box, and then click Apply.

Call Activity

The Call Activity tab (see Figure 47) enables you to set the thresholds for the selected 
work flow group for call duration at a particular type of device (Route Point and Agent) 
while a call is in the contact center.

If a call remains at a device longer than the defined Caution or Warning threshold, a 
Caution or Warning icon is displayed next to the device name in the Agent Desktop call 
activity pane.
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Figure 47. Call Activity tab. 

To set up call activity thresholds:

1. On the Call Activity tab, enter the threshold times as desired.

Enter values in the Warning fields before entering values in the Caution fields. 
Desktop Administrator will not accept data entered in the Caution fields if no 
data appears in the Warning fields.

The Warning threshold value must be greater than the Caution threshold 
value. If you enter a greater value in the Caution field, Desktop Administrator 
automatically changes it so that it is one second less than the Warning value.

Maximum Warning value:59 minutes, 59 seconds 
Maximum Caution value:59 minutes, 58 seconds

2. Click Apply to save your changes.
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CAD, CAD-BE, and IP Phone Agent

The CAD Agent, CAD-BE Agent, and IP Phone Agent nodes enable you to configure 
various functions for each type of agent within the selected work flow group.

CAD Agent

You can configure the following for agents using Cisco Agent Desktop:

■ User Interface (page 98)

■ Voice Contact Work Flows (page 111)

■ Agent Management Work Flows (page 118)

CAD-BE Agent

You can configure the following for agents using Cisco Agent Desktop Browser Edition:

■ User Interface (page 98)

■ Voice Contact Work Flows (page 111)

IP Phone Agent

The Recording node under the IP Phone Agent node enables agent-initiated recording 
for agents who use the Cisco IP Phone Agent service.

NOTE:  If your CAD system is configured to use Cisco Unified 
Communications Manager-based monitoring, the IP Phone Agent 
node is not available.

When enabled, the IP Phone Agent service has soft key options for starting and 
stopping recording. The IPPA agent can then record his or her own phone 
conversations, and these recordings can be reviewed by the supervisor using 
Supervisor Record Viewer.

See the Cisco IP Phone Agent User Guide and the Cisco Supervisor Desktop User 
Guide for more information.

To enable IPPA agent-initiated recording:

1. Select the Enable IPPA Recording check box.

2. Click Apply to save your changes.
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User Interface

The User Interface window enables you to configure the appearance and behavior of 
Agent Desktop (when accessed under the CAD Agent node) and Agent Desktop 
Browser Edition (when accessed under the CAD-BE Agent node).

NOTE:  The User Interface windows for CAD Agent and CAD-BE Agent 
are slightly different to allow for the differences in the two 
applications. The following section will discuss the CAD Agent version 
and note where it is different for CAD-BE Agent.

Toolbar

The Toolbar tab (see Figure 48) enables you to:

■ Adding and Removing Toolbar Buttons (page 99)

■ Associating Actions with Task Buttons (page 99)

■ Changing a Task Button’s Hint (page 100)

■ Customizing Button Icons (page 100)

■ Show Data Fields (page 101)

Figure 48. Toolbar tab.

CAD Agent version CAD-BE Agent version
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Adding and Removing Toolbar Buttons

The pane on the left of the Toolbar tab displays the buttons that are available to be 
used on the Agent Desktop toolbar. Buttons that are assigned show an icon next to 
them; unassigned buttons do not show an icon. 

You cannot change the hint or the shortcut key combination on any of the standard 
buttons, or assign an additional action to them. You can, however, customize the icon 
displayed on the button (see "Customizing Button Icons" on page 100).

To add a button to the toolbar:

1. In the list of buttons, select the available button you want to add.

2. Select the Visible check box, and then click Apply.

Removing a button from the toolbar:

1. In the list of buttons, select the button you want to remove.

2. Clear the Visible check box, and then click Apply.

Adding the Cisco Unified Outbound Dialer Toolbar

The Cisco Unified Outbound Dialer feature is available only for Agent Desktop users. 
You cannot add the Outbound Dialer toolbar to CAD-BE.

To add an Outbound Dialer toolbar to Agent Desktop:

■ In the Outbound Dialer Mode section, check the type of dialing mode your 
calling campaign will use, and then click Apply. 

NOTE:  The Outbound Dialer Mode section appears on the Toolbar tab 
only if Outbound Dialer is enabled in ICM. If it is not enabled, this 
section is blank.

You can select more than one dialing mode check box.

The appropriate buttons for that type of calling campaign are added to the 
Agent Desktop toolbar. 

For more information, see "Cisco Unified Outbound Dialer" on page 158.

Associating Actions with Task Buttons

You can associate as many actions with a task button as you wish. The actions are 
executed sequentially in the order they are listed in the Actions window. 
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NOTE:  Bear in mind the amount of time it takes to execute actions. 
Generally, a maximum of two or three actions per task button is 
recommended.

The default task buttons display icons of the numbers 1 through 10. You can 
customize these icons if you wish.

To associate an action with a task button:

1. Select a task button from the list of available buttons. 

2. Select the Visible check box.

The Actions pane and its associated buttons become enabled.

3. Under the Actions pane, Click Add.

The Select Action window appears. 

4. Select the action you want to associate with the button.

You can select an existing action or set up a new action. (See "Actions" on 
page 122 for more information on setting up new actions.)

5. Click OK.

The Toolbar tab is displayed.

6. Type a short description of the action in the Hint field. You can replace only 
the hint; you cannot change the shortcut key combination.

7. Repeat Steps 3–6 if you want to add other actions to the same task button. 

8. Click Apply to save your changes.

Changing a Task Button’s Hint

You can change the hint (the text an agent sees when the mouse hovers over a button) 
associated with a task button. 

You cannot change the hint associated with a standard button, or change the shortcut 
key combination of any button.

To change a task button’s hint:

1. Select the button whose hint you want to change.

2. In the Hint field, type the hint you want displayed to the agent.

3. Click Apply to save your changes.

Customizing Button Icons

Buttons can be customized by applying different icons to them. A library of available 
icons is supplied with Desktop Administrator, or you can use icons of your own.
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If you use your own icons, the icon file is written to Directory Services when it is 
applied to a button so that it is available to all instances of Agent Desktop. 

Custom icons must meet the following specifications.

■ ICO format

■ 16 × 16 or 32 × 32 pixels

■ up to 256 colors

To customize an icon:

1. Choose the button whose icon you want to customize.

2. Click Customize Icon.

The Choose Icon dialog box appears (see Figure 49).

Figure 49. Choose Icon dialog box.

3. Choose an icon. 

The icon is displayed in the Preview area.

You can also click Browse to navigate to another location if you wish to use 
your own icon. 

4. Click OK. 

The button is displayed with the new icon on it in the button list.

Show Data Fields

The Show Data Fields tab (see Figure 50) configures the data fields that appear in the 
contact appearance pane in Agent Desktop, and enables you to rename data fields.
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NOTE:  CAD-BE agents must logout, exit, and log in again for changes 
to take effect.

Configuring and Renaming Data Fields

The left pane displays the fields that appear in Agent Desktop. The right pane displays 
the available fields. 

NOTE:  The left pane must contain at least one field.

To configure the data fields that appear in Agent Desktop:

1. Use the left and right arrows to move the available fields between the left and 
right panes, and the up and down arrows to set the left-to-right order in which 
the fields will appear in Agent Desktop.

2. Click Apply to save your changes.

Figure 50. Show Data Fields tab.

To rename a data field:

1. Double-click the field you want to rename.

The Rename dialog box appears (see Figure 51). 
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Figure 51. Rename dialog box.

2. Enter a new name, and then click OK.

Miscellaneous

Use the Miscellaneous tab (Figure 52) to configure other user interface options. 
Select or check your desired settings, and then click Apply to save your changes.

Figure 52. Miscellaneous tab.

CAD Agent version CAD-BE Agent version
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Browser Setup

Use the Browser Setup tab (Figure 53) to configure the Integrated Browser portion of 
Agent Desktop. On this tab you can:

■ Enable/disable the integrated browser window

■ Set the default web page displayed by the browser

■ Enable up to 5 browser tabs

■ Enable/disable agents’ access to other websites 

■ Add work sites (or “favorites”) so agents can quickly access frequently-used 
websites

Table 11. Miscellaneous tab options. 

Option Description

Window Behavior Specify how you want the Agent Desktop window to 
behave:

• Normal. The window appears when calls are present 
and minimizes when idle.

• Keep Open. The window is always visible, but may be 
hidden by other open applications.

• Always on Top. The window is always visible and on 
top of other open applications.

• Stealth. The window appears as an icon in the 
system tray.

Macro Hot Key Specify the key you want to use to pause macro 
recording and display the Suspend Macro Recording 
dialog. The default is F2.

Rules and Actions only 
apply to the first call 
appearance

Select to invoke rules processing only for the oldest 
(top) call appearance. If the box is not selected, rules 
processing is invoked for all inbound calls.

Report Window is 
always on top

Configures the Agent Desktop Reports window to stay 
on top any other application whenever it is opened.
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Figure 53. Browser Setup tab (left—CAD Agent, right—CAD-BE Agent).

Enabling the Integrated Browser

Enable or disable the integrated browser in Agent Desktop/CAD-BE by selecting or 
clearing the Enable Integrated Browser check box.

Enabling Access to Other Websites

Enable or disable an agent’s access to other websites by selecting or clearing the 
Allow Address Editing check box. When selected, the Address field appears in the 
integrated browser window, and agents can enter the URL of a website they wish to 
view. When deselected, the Address field does not appear in the integrated browser 
window.

Configuring the Number of Browser Tabs

Choose 0 to 5 in the Number of Workflow Browsers field to set how many browser tabs 
appear in Agent Desktop (this feature is not available in CAD-BE). If you choose 0, only 
the supervisor push page tab appears—it is always enabled. If you choose 1 to 5, that 
many tabs in addition to the supervisor push page tab appear. 

Work flow HTTP actions can be set up to display web pages in a specific browser tab. 
See "HTTP Action" on page 132 for more information.

CAD Agent version CAD-BE Agent version
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Setting Up the Home Page

A home page is the website that appears in an integrated browser tab when Agent 
Desktop is started. The default home page is www.cisco.com. If no home page is 
configured (the default is deleted), the integrated browser tab is blank.

Each browser tab can have its own home page. 

To configure a home page:

1. From the Browser Tab drop-down list, select the tab where you want the home 
page to appear.

2. In the Home Page field, type the web address (URL) of the website you want to 
appear by default in the integrated browser.

3. Click Update.

4. Repeat steps 1 through 3 for each tab as desired.

5. Click Apply to save your changes.

The home page is set. 

Setting Up Work Sites

A work site is a website that is frequently accessed by agents to assist them in their 
jobs. They are similar to the “favorites” you can set up in a web browser. 

Work sites you set up appear in a drop-down list in the agent’s integrated browser, and 
are available no matter which tab is displayed. When the agent selects a work site 
from the list, it is displayed in the integrated browser window. This allows the agent 
quick access to the site without having to type its address in the (optional) Address 
field.

To add a work site:

1. In the Site Name field, type the name of the website you wish to add as a work 
site.

2. In the URL field, enter the web address of the website.

3. Click Add.

The work site is added to the list in the Work Sites pane.

4. Click Apply to save your changes.

To update a work site:

1. In the Work Sites field, select the work site you wish to update. 

The information for the website appears in the Site Name and URL fields.

2. Edit the information as needed, and then click Update.
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The updated information appears in the Work Sites pane.

3. Click Apply to save your changes.

To delete a work site:

1. In the Work Sites pane, select the work site you wish to delete.

The information for the website appears in the Site Name and URL fields.

2. Click Delete.

The work site is deleted from the Work Sites pane.

3. Click Apply to save your changes.

Remote Access

The Remote Access tab (see Figure 54) is used to enable the IPC Receive Event 
feature and configure the port used by the feature. 

NOTE:  The Remote Access feature is not available for CAD-BE.

An IPC Receive Event occurs when a third party application sends a message to Agent 
Desktop over a UDP socket. These messages must adhere to a predefined XML 
schema (see examples below) and cannot exceed 4000 bytes. 

When Agent Desktop receives an IPC Receive Event message, it does not send a reply 
back. IPC Receive Events are queued so no messages are lost.

By default, IPC Receive Events are disabled. The default port number is Port 58000. 

NOTE:  The Remote Access action provides for receiving an 
asynchronous event. Even if the event is solicited by an IPC Action 
request being sent out, the request may never be delivered, and there 
is no assurance that a response will arrive because of the nature of 
UDP.
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Figure 54. Remote Access tab.

Four actions are supported by the IPC Receive Event:

■ IPC Make Call

■ IPC High Priority Chat 

■ IPC Record

■ IPC Agent Notification

IPC Make Call Action

For the IPC Make Call action to be successful:

■ The agent must be in the Not Ready state

■ There can be no call appearance present in Agent Desktop

■ The Make Call dialog box must be closed (if it is open, the action will close it)

The message sent to Agent Desktop must conform to this XML format. Bold text 
indicates a variable that must be replaced with your own values.

<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
<IPCMakeCallAction>
<ActionName>IPC Make Call Action</ActionName>
<PhoneNumber>2961</PhoneNumber>
<DisplayError>true</DisplayError>
</IPCMakeCallAction>
</IPCActions>
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IPC High Priority Chat Action

For the IPC High Priority Chat action to be successful, the agent must be logged in.

The message sent to Agent Desktop must conform to this XML format. Bold text 
indicates a variable that must be replaced with your own values.

<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
<IPCHighPriorityChatAction>
<ActionName>IPC High Priority Chat Action</ActionName>
<MessageText>Need help from supervisor</MessageText>
</IPCHighPriorityChatAction>
</IPCActions>

IPC Record Action

For the IPC Record action to be successful:

■ A call appearance must be present in Agent Desktop

■ The call must be connected, on hold, or conferenced

■ The call must be the first call appearance listed in Agent Desktop

The message sent to Agent Desktop must conform to this XML format. The action 
supports two commands: start and stop. 

<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
<IPCRecordAction>
<ActionName>IPC Record Action</ActionName>
<Command>start</Command>
<DisplayError>true</DisplayError>
</IPCRecordAction>
</IPCActions>

IPC Agent Notification Action

For the IPC Agent Notification action to be successful, the agent must be logged in.

The message sent to Agent Desktop must conform to this XML format. Bold text 
indicates a variable that must be replaced with your own values.

<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
<IPCAgentNotificationAction>
<ActionName>IPC Agent Notification Action</ActionName>
<MessageText>Go to Not Ready state!</MessageText>
</IPCAgentNotificationAction>
June 2007 109



Cisco Desktop Administrator User Guide
</IPCActions>
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Voice Contact Work Flows

Voice contact work flows manage agent activity based on voice call events. Once a call 
is classified it is further filtered according to events, rules, and actions. Voice contact 
work flows are available to CAD and CAD-BE agents.

Figure 55. Voice Contact Work Flows flow chart.

For example, a voice contact work flow could be set up as follows:

1. A call comes into the contact center and is routed to an agent in the Ready 
state.

2. The Voice Contact Classification filter determines which work flow to select. It 
examines the inbound call’s enterprise data (original dialed number) and 
determines that it is a call for Product A technical support and thus meets the 
data conditions of Work Flow 1. The call is now subject to the second layer of 
filtering set up in Work Flow 1.
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3. Work Flow 1 says that any ringing event on the Product A support line triggers 
an HTTP action. This action takes the customer-entered account information 
from the IVR (part of the call’s enterprise data) and pops a web page in Agent 
Desktop’s or CAD-BE’s integrated browser that displays the customer’s 
account information to the agent. 

4. The agent answers the phone call and is ready to assist the customer.

Creating a Voice Contact Work Flow

The general procedure for creating a voice contact work flow is as follows:

1. Set up a new voice contact classification filter:

a. Select the type of call the work flow applies to—inbound, outbound, or all 
calls.

NOTE:  Depending on which Outbound Dialer dialing mode you are 
using, a customer call can appear as inbound or outbound. Therefore, 
when creating an Outbound Dialer work flow, select all calls as your 
voice classification filter.

b. If required, further classify the call by specifying it must meet various data 
field conditions.

2. Set up the second level of filtering: 

a. Select the call or agent state event—Ringing, Answered, Dropped, Work 
Ready, or Work Not Ready.

b. If required, set up one or more rules with data field conditions that the 
call must meet.

c. Set up one or more actions that will take place if the call or agent event 
meets the rules’ data field conditions.

3. Set up as many second level filters as needed for calls selected by the first 
level filter. You can set up rules and actions for each of the filtered call’s call 
or agent events.

NOTE:  It is possible to set rules and conditions that are contradictory 
so that a work flow cannot function. Desktop Administrator does not 
check a work flow’s logic and validity. If a work flow fails to operate as 
expected, make sure that the rules and conditions you set up are 
logically valid.
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Setting Up a New Voice Contact Classification

When you select the Voice Contact Work Flow node in the navigation tree, the Voice 
Contact Work Flow List window is displayed. This window shows all the existing voice 
contact work flows, and enables you to edit them or to set up new ones.

The Voice Contact Classification is the first level of filtering in a voice contact work 
flow.

To set up a new voice contact classification:

1. In the Voice Contact Work Flow List window, click Add.

The New Work Flow Name dialog box is displayed.

2. Enter a name for your new voice contact work flow, and then click OK.

The Edit Voice Contact Classification dialog box appears. Note that the work 
flow name you just created is shown in the dialog box.

3. Set up the criteria for the first level filter in this dialog box. 

a. Select the type of call you want the filter to apply to from the drop-down 
list: inbound calls, outbound calls, or all calls.

Note that there is also the option to disable the work flow. You can select 
this option later on if and when you want to disable the work flow, but 
want to keep the work flow on file for enabling at a later date.

b. Apply up to three data field conditions. Click Edit to display the Data Field 
Condition dialog box. For information on setting up a data field condition, 
see "Data Field Conditions" on page 115.

c. Select if you want the filter to apply when ALL conditions are true, or if 
ANY conditions are true. 

4. Click OK to complete setting up the first level filter in the new voice contact 
work flow.

Setting Up a New Work Flow

After a new voice contact classification is created, Desktop Administrator takes you to 
the Voice Contact Work Flow window (see Figure 56). In this window you set up the 
second level of filtering, consisting of events and rules, and the resulting actions for 
your new voice contact work flow.
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Figure 56. Voice Contact Work Flow window.

When an event occurs, the rules associated with the event are evaluated in the order 
they are listed in the Rules pane. When a rule is met, the actions associated with that 
rule are executed in the order they are listed in the Actions pane. Subsequent rules 
are not evaluated.

If no rules are met, the default rule governs, and all actions associated with the 
default rule are executed. Default rules cannot be changed or deleted.

The default action might be <no action>. 

To set up a new work flow:

1. Select the event that triggers the work flow from the Event pane. The available 
events are:

— Ringing. The agent’s phone rings.

— Answered. The agent answers the phone.

— Dropped. The call terminates.

— Work Ready. The agent transitions to the Work Ready agent state.

— Work Not Ready. The agent transitions to the Work Not Ready agent state.

2. Under the Rules pane, click New to set up a new rule. 

The New Rule Name dialog box appears. 

3. Enter the name of the new rule, and then click OK.

The fields in the Current Rule Conditions section of the window are enabled.
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4. Add up to 3 data field conditions (see "Data Field Conditions" on page 115 for 
more information) and specify when the actions should be executed—when 
any one of the data field conditions is met, or when all of the data field 
conditions are met.

When a data field condition is established, the Enable Rule check box is 
automatically selected.

5. Under the Actions pane, click Add to choose one or more actions to run when 
the event occurs and the rules are met. 

You can select an existing action, or create a new action. If the action you 
select cannot be associated with the event, you will receive an error message. 
See "Actions" on page 122 for more information. 

6. Repeat steps 1 through 5 for as many events as desired. 

7. When you are finished associating events with rules and actions, click Apply 
to save the new voice contact work flow.

Data Field Conditions

Data field conditions are criteria that a call’s selected enterprise data fields must 
meet in order for a voice contact classification or a work flow rule to be enforced. 

You can configure up to 3 data field conditions for a voice contact classification filter 
and for a work flow rule. You specify if all the data field conditions must be met (an 
AND statement) or if any of the data field conditions must be met (an OR statement). 

To do this you use the Data Field Condition dialog box (for a voice contact 
classification) or the Current Rule Conditions section of the Voice Contact Work Flow 
window (for a work flow rule). 

Figure 57. Data Field Condition dialog box.
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To set up data field conditions:

1. In the Voice Contact Classification dialog box, click Edit. In the Voice Contact 
Work Flow window, add a new rule and then click Edit in the Current Rule 
Conditions section of the window. 

2. Select a data field from the Data Field drop-down list.

The Data Field lists all the enterprise data fields used in your system. 

Not all data fields are available for all events, for instance, Calling# and 
Called# are not available for the Ringing event.

3. Specify one of the data field filters:

— Is Empty. The data field is empty.

— Is Not Empty. The data field is not empty.

— Is In the List. The data field is compared to the list you set up in the List 
pane to determine if it is in that list. Click Add to add an item to the list of 
strings. Strings are not case sensitive. You can use wild cards (* and ?) to 
simplify your list. See "Wild Card Searches" on page 116. 

— Is Not in the List. The data field is compared to the list you set up in the 
List pane to determine if it is not in that list. Click Add to add an item to 
the list of strings. Strings are not case sensitive. You can use wild cards (* 
and ?) to simplify your list. See "Wild Card Searches" on page 116.

— Length of Data. The length of the data field is between a minimum and 
maximum number of characters that you set. 

4. Ensure that the Enable Condition check box is selected, and then click OK.

Wild Card Searches

You can use wild cards when entering strings in the data field conditions list pane. 
This enables you to avoid having to enter many strings if the strings you want to list 
have common elements. 

Wild card characters used are the asterisk (*) and the question mark (?). 

An asterisk in a string replaces any quantity of characters, as long as the other 
characters in the string match. For instance, ABC* matches strings that begin with 
ABC but end in any quantity of any characters.

A question mark in a string replaces any character, but the length of the string must 
be exactly as represented. For instance, ABC?? matches strings that begin with ABC 
and end in 2 other characters.

Double quotes around a string searches for the exact characters within the double 
quotes, including the wild card characters (*) and (?). For instance, “123*ABC” 
matches only the string 123*ABC, and does not allow the asterisk to act as a wild 
card.
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Modifying a Voice Contact Work Flow

You can modify both any custom work flows you create and the default work flow.

NOTE:  The classification filter for the Default work flow is Inbound 
Calls. This cannot be changed. 

To modify a voice contact work flow:

1. From the Voice Contact Work Flow List, select the work flow you want to 
modify, and then click Edit.

If you selected a custom work flow, the Edit Voice Contact Classification dialog 
box appears. 

If you select the default work flow, the Voice Contact Work Flow window 
appears. The default work flow does not classify voice contacts, and so 
bypasses the Edit Voice contact Classification dialog box.

2. Modify the voice contact classification if desired, and then click OK to proceed 
to the Voice Contact Work Flow window.

3. Modify the work flow as desired, and then click Apply to save your changes.

Deleting a Voice Contact Work Flow

You can delete any custom work flow you create. You cannot delete the default work 
flow.

To delete a voice contact work flow:

1. From the Voice Contact Work Flow List, select the work flow you want to 
delete, and then click Delete.

A popup window appears asking you to confirm you want to delete the work 
flow.

2. Click OK to confirm the deletion.
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Agent Management Work Flows

Agent management work flows manage agent activity based on Agent Desktop 
activity, agent ACD states, and time of day. The work flows follow the event—rule—
action behavior used by voice contact work flows. There is a major difference—there is 
no initial filtering similar to the voice contact classification applied to voice contacts.

Figure 58. Agent Management Work Flows flow chart

For example, agent management work flows could be set up as follows:

■ Every work day at 4:30, agents receive a popup message reminding them to 
complete their time cards.

■ Whenever Agent Desktop starts up, Notepad is launched on the agent’s 
desktop.

■ Whenever an agent logs in, the customer database is launched.

Creating an Agent Management Work Flow

The general procedure for creating an agent management work flow is as follows:

1. Select the event that triggers the work flow.

2. If the event is time of day, set up a rule with one or more data conditions that 
the event must meet.
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NOTE:  It is possible to set rules and conditions that are contradictory 
so that a work flow cannot function. Desktop Administrator does not 
check a work flow’s logic and validity. If a work flow fails to operate as 
expected, make sure that the rules and conditions you set up are 
logically valid.

3. Set up one or more actions that will take place whenever the event occurs, or, 
if a time of day event, whenever the rule is met. 

When you select the Agent Management Work Flow node, the Work Flow window 
appears (see Figure 59).

Figure 59. Work Flow window.

Unlike rules in voice contact work flows, rules in agent management work flows can be 
applied only to a time of day event, not to all events.

Not all actions are available for agent management work flows. See "Action 
Availability" on page 123 for more information.

To set up a CAD activity or agent state work flow:

1. Select the event that triggers the work flow from the Event pane. The available 
events are:

— Startup. Agent Desktop starts.

— Shutdown. Agent Desktop closes.

— Logged in. The agent logs into Agent Desktop.

— Logged out. The agent logs out of Agent Desktop.
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— Ready. The agent transitions to the Ready state.

— Not Ready. The agent transitions to the Not Ready state.

2. Under the Actions pane, click Add to choose one or more actions to run when 
the selected event occurs. 

You can select an existing action, or create a new action. See "Actions" on 
page 122 for more information.

3. Repeat steps 1 and 2 for as many events as desired. 

4. When you are finished associating events with actions, click Apply to save the 
agent management work flow.

To set up a time of day work flow:

1. Select the Time of day event from the Event pane. 

2. Under the Rules pane, click New to set up a new rule. 

The New Rule Name dialog box appears. 

3. Enter the name of the new rule, and then click OK.

The fields in the Current Rule Conditions section of the window are enabled, 
and the Time of Day Condition dialog box appears.

Figure 60. Time of Day Conditions dialog box with Days of the week selected (left) and Date 
selected (right),

4. Set up the day or date conditions for the rule, and then click OK. 

a. To specify that an action takes place every week on certain days or at a 
certain time, select Day(s) of the week and then check the desired days. 
You must specify a time of day as well.
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b. To specify that an action takes place on a specific date, select Date, and 
then select the desired date from the calendar. Today’s date is circled in 
red. You must specify a time of day as well.

The condition you set up is automatically entered in the first Data Field 
Conditions line in the Current Rule Conditions section of the Work Flow 
window, and the Enable Rule check box is automatically selected.

5. Click Edit next to the 2 remaining Data Field Conditions fields to further define 
the rule, if desired: 

■ Specify if the agent is on hook or off hook

■ Specify if the agent state is or is not equal to Ready or Not Ready

Figure 61. State Condition dialog box

6. Under the Actions pane, click Add to choose one or more actions to run when 
the event occurs and the rules are met. 

You can select an existing action, or create a new action. See "Actions" on 
page 122 for more information.

7. Click Apply to save the new time of day work flow.
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Actions

Actions are stored independently of events and rules. You can use an action in more 
than one event, and you can assign actions to more than one task button in Agent 
Desktop.

While actions are processed, events are queued. It is generally a good idea to avoid 
long actions. 

Table 12. Actions and their availability to CAD and CAD-BE agents

Action Type and Description CAD CAD-BE

Importing and Exporting Actions (page 125). Displays a 
popup message on the agent’s desktop. ×

Agent State Action (page 129). Sets an agent state. ×

Call Control Action (page 131). Answers, drops, 
conferences, transfers, or makes a call, or inputs touch 
tones during a call.

×

HTTP Action (page 132). Enables the Agent Desktop 
integrated browser to interact with a web application. × ×

IPC Action (page 139). Passes enterprise data or 
user-defined data from the agent desktop to a custom 
third-party application.

×

Launch External Application Action (page 141). Starts a 
third-party application. ×

Run Macro Action (page 143). Plays back a recorded 
sequence of keystrokes. ×

Set Enterprise Data Action (page 153). Automatically 
changes an enterprise data field in Agent Desktop to a 
selected desktop variable or static text.

×

Timer Action (page 154). Triggers actions after a specified 
time has elapsed. ×

Utility Action (page 156). Run a utility, such as start and 
stop recording or sending a predefined, high-priority chat 
message to a supervisor.

× ×
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Action Availability

Not all actions are available for all events or for all types of agents. Table 13 shows 
which actions are available for the three types of work flows and for each type of agent 
(CAD agents and CAD-BE agents). 

Adding a New Action

To add a new action:

1. Access the Voice Contact Work Flow or Agent Management Work Flow window.

2. Select the event to be associated with the new action.

3. Under the Actions pane, click Add.

The Select Action dialog box appears (see Figure 62).

Table 13. Action availability per work flow type and agent type* 

* “×” indicates the action is available: “—” indicates the action is not available.

Action Type

Voice Contact Agent Mgmt Time of Day

CAD CBE CAD CBE CAD CBE

Agent Notification × — × — × —

Agent State × — — — × —

Call Control × — — — — —

HTTP × × × — × —

IPC × — × — — —

Launch External Application × — × — — —

Run Macro × — × — — —

Set Enterprise Data × — — — — —

Timer × — — — — —

Utility × × — — — —
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Figure 62. The Select Action dialog box.

4. Choose the tab for the type of action you want to associate with the event. 

5. If the action already exists, select it, and then click OK.

If the action does not yet exist, click New and follow the instructions for setting 
up that type of action as outlined below.

6. Click OK.

The Select Action dialog box closes and you return to the Work Flow window. 
The new action is listed in the Actions pane.

Editing an Action

To edit an action:

1. In the Work Flow window, select the appropriate event, and then select the 
action you want to edit from the Actions pane. 

2. Click Edit.

The edit dialog box for that action appears.

3. Make your changes, and then click OK.

The action is now changed.

Deleting an Action

To permanently delete an action, you must first delete it from any event it is 
associated with, and then delete the action itself. 
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To permanently delete an action:

1. In the Work Flow window, select each event. If the action you want to delete is 
associated with that event, select the action in the Action pane and then click 
Delete to remove it from that event.

The action is now removed from all events.

2. Under the Actions pane, click Add.

The Select Actions dialog box appears.

3. Choose the appropriate tab, and then select the action you want to delete.

4. Click Delete.

The action is deleted.

5. Click Cancel.

The Select Action dialog box closes and you return to the Work Flow window.

Importing and Exporting Actions

You can export actions associated with a specific work flow group and import them to 
other work flow groups. The actions are exported to any location you choose, locally or 
on a network drive. 

NOTE:  If you export actions to the default location (C:\Program 
Files\Cisco\Desktop\config\Action) they will be lost in the event that 
a client desktop is reinstalled. 

The actions you export can also be imported by other instances of Desktop 
Administrator, belonging to your system or any other system, as long as those 
instances are the same version of Desktop Administrator and can access the file 
storage folder.

Types of actions that can be exported and imported are:

■ Run Macro action

■ HTTP action

■ IPC action

■ Launch External Application action

The rules and events associated with the actions are not part of this function and 
cannot be exported or imported. 

You can export only one action at a time. For example, if there are five actions you 
want to export from a work flow group, you must export each action individually. 
June 2007 125



Cisco Desktop Administrator User Guide
You can add a description (limited to 255 characters) to the exported action for easier 
identification when importing to another work flow group. 

If an imported action has the same name as an action already present in the work 
flow group, you will be prompted to rename the imported action.

To export a work flow action:

1. Select the work flow group whose action you want to export.

The Import Export Work Flow Actions window appears (see Figure 63). 

If there are actions available for import and/or export, the Import and/or 
Export button is enabled. If there are no actions available for the specific 
action, that button is disabled.

Figure 63. Import Export Work Flow Actions window.

2. Click Export. 

The Export Action dialog box appears (see Figure 64).
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Figure 64. Export Action dialog box.

3. Select the action you want to export from the Action List, and then complete 
the fields in the dialog box:

■ Folder Path: Select the default path shown or browse to any other local or 
network folder location.

■ Description (optional): Enter a description of the action. Maximum length 
of the description is 255 characters.

4. Click OK.

To import a work flow action:

1. Select the work flow group to which you want to import an action.

The Import Export Work Flow Actions window appears (see Figure 63). 

2. Click Import.

The Import Select dialog box appears (see Figure 65).
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Figure 65. Import Select dialog box.

3. Navigate to the folder where actions are stored. The field is autofilled with the 
default path.

4. From the Action Names list, select the action you want to import to the work 
flow group. You can import only one action at a time. 

5. Click OK.

Agent Notification Action

An Agent Notification action displays a custom message popup window on the agent’s 
desktop when a certain event occurs. For instance, when an agent logs out, a popup 
window reminding the agent to complete his time card could pop up on his desktop. 

To set up an Agent Notification action:

1. Set up a new action. See "Adding a New Action" on page 123.

The Select Action window appears.

2. Select the Agent Notification tab, and then click New.

The Agent Notification Action Setup dialog box appears (see Figure 66).
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Figure 66. Agent Notification Action Setup dialog box.

3. Enter an action name, select the icon you want to appear in the popup 
window, and then type your message.

4. Click Preview to see what the popup window will look like (see Figure 67).

Figure 67. Preview of an Agent Notification popup window.

5. Click OK.

Agent State Action

An Agent State action enables you to select an agent state to associate with an event. 

Agent State actions may be associated only with Answered and Dropped events. The 
only valid agent states are Ready, Not Ready, Work Ready, and Work Not Ready.

NOTE:  You can associate these states with the Dropped event, but if 
agent state transitions are configured in ICM, that setting will 
probably take precedence over the agent state action you configure 
here. 

To set up an Agent State action:

1. Set up a new action. See "Adding a New Action" on page 123.

The Select Action window appears.

Select the Agent State tab, and then click New.

The title bar on the actual popup window may 
contain truncated text, because Windows 
automatically adds “Cisco Agent Desktop” to 
the beginning of the title bar text and the popup 
window does not resize.
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The Agent State Action Setup box appears (see Figure 68).

Figure 68. Agent State Action Setup dialog box.

2. Enter a name for the action, select the agent state control from the drop-down 
list, and then click OK.

Automated Reason Codes for Agent State Changes

You can enable automated reason codes when you set up an agent state action for 
transitioning to Logout or Not Ready. 

If you enable automated reason codes, the agent does not have to choose the 
appropriate reason code when an agent state action to transition to Logout or Not 
Ready is triggered.

To enable automated reason codes

1. Set up a new Agent State action (see "Agent State Action" on page 129) or 
edit an existing Agent State action (see "Editing an Action" on page 124). 

2. In the Agent State Action Setup dialog box, enter a name for the action, select 
either AgentNotReady or AgentLogout from the Agent State Control drop-down 
list. 

The Automate Reason button appears in the dialog box (see Figure 69). 

Figure 69. Agent State Action dialog box with Automate Reason button.

3. Click Automate Reason. 

The Select Reason dialog box appears (see Figure 70).
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Figure 70. Select Reason dialog box.

4. Select the reason code you want to be entered automatically when the action 
is triggered, and then click OK.

The default is “Agent will choose.” If you select this, the agent will have to 
manually enter the reason code. 

The dialog box closes and the Agent State Action Setup dialog box is 
displayed, with the number of your chosen reason code entered in the gray 
box next to the Automate Reason button. 

5. Click OK. 

Call Control Action

Call Control actions include:

■ Blind transfer

■ Supervised transfer

■ Supervised Conference

■ Blind Conference

■ Call

■ Answer

■ Drop

■ TouchTones

These actions can be associated with an event or a task button. For example, a task 
button could be configured to execute a call control action that blind transfers a call to 
the agent’s supervisor.

To set up a Call Control action:

1. Set up a new action. See "Adding a New Action" on page 123.
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The Select Action window appears.

Select the Call Control tab, and then click New.

The Call Control Action Setup dialog box appears (see Figure 71).

Figure 71. Call Control Action Setup dialog box.

2. Enter the following information:

■ A name for the call control action.

■ The type of action selected from the Call Control drop-down list.

■ A phone number if required by the type of action. For example, for Blind 
Transfer, enter the phone number to which a call is transferred.

3. Click OK.

NOTE:  A blind conference call control action must be used in 
conjunction with rules. If no rules are configured, then the blind 
conference action occurs every time the event it is associated with 
occurs. For example, if you set up a blind conference action on an 
answered event and do not configure rules, it executes on every 
answered call. To prevent this, you must set up rules that allow the 
action to occur only when desired, such as only on incoming calls 
from the route point. 

NOTE:  A work flow set up to answer a call on the Ringing event does 
not work for mobile agents in Call-by-Call mode because the agent 
must answer incoming calls manually.

HTTP Action

This action is available to CAD agents at the Premium level (Post and Get), and to 
CAD-BE agents at the Enhanced and Premium levels (Get only). 

HTTP actions enable an agent to use call-based data to interact with a website or a 
web application in the Integrated Browser window.

For example, an HTTP action can be set up so the enterprise data of an incoming call 
is used to retrieve a customer record and display it in the Integrated Browser. 
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NOTE:  For more information on HTTP requests and the HTTP protocol 
in general, see the website of the World Wide Web Consortium, 
www.w3.org.

NOTE:  Keep in mind that a URL, including arguments, is limited by 
the HTTP service to a maximum of 2075 characters. If you create an 
HTTP action that results in a URL longer than that, it will not work 
correctly. 

To set up an HTTP action:

1. Set up a new action. See "Adding a New Action" on page 123.

The Select Action window appears.

Select the HTTP Action tab, and then click New.

The HTTP Actions Setup dialog box appears (see Figure 72).

2. Complete the HTTP Actions Setup dialog box as follows:

Field Description

Action Name Enter a name for the new action.

Protocol Select the protocol to be used by the browser: http 
(default) or https.

Method Select the http method to be used by the browser: GET 
(default, CAD and CAD-BE agents) or POST (CAD agents 
only).

Host Enter the host name or IP address of the website. Do not 
include the http or https prefix.

Port Enter the port (0–65535) that the host is listening on 
(for http the default is 80; for https, the default is 443). 

Path Enter the path portion of the URL (optional). Default is 
blank. Do not include a leading slash.

Browser Tab Select the browser tab in which you want the action 
results to be displayed. (For CAD-BE agents there is only 
1 tab available so this field is not present.)

If the tab you select is removed later, the action will be 
displayed in the first tab (ordinarily reserved for 
supervisor page push).
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Figure 72. HTTP Actions Setup dialog box.

3. Click Add to display the HTTP Request Data dialog box (see Figure 73).

The fields added with this dialog box make up the query or post data portion 
of the request. The fields are optional and are blank by default.

Figure 73. HTTP Request Data dialog box
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4. Complete the HTTP Request Data dialog box as follows:

5. Continue to build your request using the Add, Edit, and Delete buttons as 
needed.

6. When you have completed building the request, click Preview to view the 
request. Note that Desktop Administrator has added the special characters 
needed for a valid HTTP request. Supported formats are as follows:

■ If a path is specified and there is request data, there will be a “/” after the 
port and a “?” after the path.

Example: http://www.site.com:80/index.jsp?name=value

■ If a path is not specified, there is request data, and the first request data 
is not DataFieldOnly, there will be a “?” after the port and no “/”.

Example: http://site.com:80?name=value

■ If a path is not specified, there is request data, and the first request data 
is DataFieldOnly, there will be a “/” after the port and no “?”.

Example: http://www.site.com:80/value

Field Description

Value Name Enter the name of the field in the web application.

Value Type Select one of the following: 

• DataField to use an enterprise data variable as the 
source of the data. This is inserted in the URL 
following the <name>=<value> format.

• UserDefined to use a specific string entered in the 
Value field. This is inserted in the URL following the 
<name>=<value> format.

• DataFieldOnly to insert any value selected from the 
Value drop-down list without following the 
<name>=<value> format.

Value If you selected a value type of DataField or 
DataFieldOnly, select the enterprise data variable from 
the drop-down list. If you selected UserDefined, enter 
the value to be used.

Test Data Enter a string of test data to simulate DataField or 
DataFieldOnly data. This field is enabled only if you 
select a Value Type of DataField or DataFieldOnly.
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■ If a path is not specified, there is more than one request data, and the 
first request data is DataFieldOnly, there will be a “/” after the port and no 
“?”.

Example: http://www.site.com:80/value&value&value…

7. When you are satisfied your request is correctly formatted, click Test to test it 
using the test data you entered when adding the request data.

Reserved Characters

There are characters that must not be used in an HTTP request. These characters are:

Symbol Description

& Ampersand

@ At sign

\ Back slash

^ Carat

: Colon

, Comma

$ Dollar sign

“ Double quote

= Equal sign

! Exclamation point

< Left angle bracket

[ Left square bracket

% Percent

+ Plus

# Pound sign

? Question mark

> Right angle bracket

] Right square bracket
136 June 2007



Actions
Example of an HTTP Request

To illustrate how to create a basic HTTP request, we will write a request that uses the 
Google search engine to search the web for “Cisco Systems.” 

To learn what value names and values go into the Google search:

1. Open your web browser and navigate to www.google.com. 

2. Type Cisco Systems in the search field and then click Google Search. 

The address bar shows the HTTP request we will create in Administrator (see 
Figure 74).

Figure 74. Google Search results page. 

3. The Address bar shows this string:

www.google.com/search?ie=UTF-8&oe=UTF-8&sourceid=gd&q=Cisco+ 
Systems&wxob=0

; Semi-colon

‘ Single quote

/ Slash

Symbol Description
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The portion of the string before the question mark is the host and the path. 
After that, all the request data is listed, separated by ampersands ( & ). 

To create the HTTP request:

1. Complete the HTTP Actions Setup dialog box with the information you 
gathered from the manual Google search (see Figure 74). 

The values are all user-defined. The value name is on the left side of the equal 
sign, and the value is on the right side of the equal sign.

Note that Google inserted a plus sign (+) between the words Cisco and 
Systems in the request string. You do not need to include that character in the 
HTTP Request Data dialog box. Desktop Administrator will add an acceptable 
string to indicate the space between the words.

2. After you have entered the request data, click Preview to view the resulting 
request string. 

It should be identical to the string displayed in the Google search results 
address bar. If you used a plus sign between the words Cisco and Systems, 
you will see “%2B” instead of the plus sign; if you used a space, you will see 
“%20”. These strings indicate a space and are an acceptable substitute for 
the plus sign.

3. Click Test to test your HTTP request. 

The request should open your browser, navigate to the Google Search page, 
and run a search for Cisco Systems.

Name Value

Host www.google.com

Path search

Browser Tab HTTP Web Browser Tab 1

Request Data ie=UTF-8

oe=UTF-8

sourceid=gd

q=Cisco+Systems

wxob=0
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Figure 75. Google Search HTTP Action Setup dialog box.

IPC Action

This action is available to CAD agents at the Premium level.

IPC actions pass information in the form of UDP (user datagram protocol) messages 
from the agent desktop to a third-party application using IPC (interprocess 
communication) methods. The third-party application can be located on the agent’s 
PC or anywhere on the network.

NOTE:  You must have a custom application written that listens for 
data sent to a specific IP address and port.

An IPC action is one-way—that is, when CAD sends data using an IPC action, it does 
not receive a response or any acknowledgement that the message was received by 
the recipient third-party application.
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The data sent is enterprise data or user-defined data. It is sent in the format:

valuename=value&name=value&name=value…

To set up an IPC action:

1. Set up a new action. See "Adding a New Action" on page 123.

The Select Action window appears.

2. Select the IPC Action tab, and then click New.

The IPC Action Setup dialog box appears (see Figure 76).

Figure 76. IPC Action Setup dialog box.

3. Complete the IPC Action Setup dialog box as follows:

4. Click Add to display the IPC Request Data dialog box (see Figure 77).

The fields added with this dialog box make up the query portion of the 
request. 

Field Description

Action Name Enter a name for the new action.

Protocol The default (and only) protocol is UDP.

IP Address Enter the IP address of the third-party application that 
will receive the data.

Port Enter the port number the third-party application is 
listening on for data.
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Figure 77. IPC Request Data dialog box

5. Complete the IPC Request Data dialog box as follows:

6. Continue to build your request using the Add, Edit, and Delete buttons as 
needed.

7. When you have completed building the request, click OK.

Launch External Application Action

Launch External Application actions start a third-party application in a new window. 

To ensure applications are running before macros attempt to use them, start them 
with launch actions assigned to the Startup event.

NOTE:  An application started by a launch action must use the same 
path on the agent’s PC as it does on the administrator’s PC or it must 
be on a network drive, or the launch action will not be successful.

When using launch actions, Agent Desktop can pass parameters such as command 
line arguments in two ways. 

The first method is to add parameters after the application path name. For example, 
the command to start Microsoft Excel and open a spreadsheet named mrmtest.xls is:

Field Description

Value Name Enter the name of the field.

Value Type Select DataField to use an enterprise data variable as 
the source of the data. Select UserDefined to use a 
specific string entered in the Value field.

Value If you selected a value type of DataField, select the 
enterprise data variable from the drop-down list. If you 
selected UserDefined, enter the value to be used.
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“c:\program files\excel.exe” “c:\my documents\mrmtest.xls”

NOTE:  Program names and command line arguments that contain 
spaces must be in quotes so that they appear as one argument rather 
than as multiple arguments.

The second method involves passing data fields as arguments. You can pass any valid 
data field while launching an application. Note that if a launch action takes place on 
the Startup event, call data may not be present. Empty or blank data fields will contain 
the string <NULL>.

To set up a Launch External Application action:

1. Set up a new action. See "Adding a New Action" on page 123.

The Select Action window appears.

2. Select the Launch External Application Action tab, and then click New.

The Launching External Application Action Setup dialog box appears (see 
Figure 78).

Figure 78. Launching External Application Action Setup dialog box.

3. Enter a name for the action and enter the path to the desired application’s 
location.

Make sure the application is located so that it is available to Agent Desktop at 
runtime.

4. Add any arguments you wish to pass to the application. 

Choose the desired argument in the Available Arguments list, and use the left 
arrow to add it to the Argument list. Use the up and down arrows to reorder 
the Argument list.
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5. When you have finished entering information, click OK. 

For more examples of setting up this type of action, see Chapter 6, “Tutorials.”

Run Macro Action

A macro is a shortcut for a sequence of keystrokes. For example, you might record a 
macro that performs the following tasks with each incoming call:

1. Copy the ANI (Automatic Number Identification) from Agent Desktop to 
Microsoft Outlook

2. Open a contact list

3. Find the ANI in a database or spreadsheet

4. Display a screen containing the caller’s account information

NOTE:  Do not use a Run Macro action to perform tasks that can be 
accomplished by one of the other types of actions available. For 
example, use a Call Control action to transfer a call, and an Agent 
State action to change agent states.

NOTE:  Run Macro actions do not work correctly when Chinese and 
Korean characters (and potentially any multi-byte characters) are 
used. 

For examples of creating macros, see Chapter 6, “Tutorials.”

Macro Recording Tips

If your macro accesses a third-party application, make sure that the application is 
open. If the macro enters text into the third-party application, make sure that 
application has Windows focus. 

Keystroke macros play back to the top level window they were recorded in. If you are 
running a keystroke macro to a Terminal Services window, you must make sure that 
the appropriate application in that Terminal Services window always has focus, 
otherwise the keystrokes will be sent to the wrong application.

Before you begin to record the macro, make a test run with the third-party application, 
writing down all of the keystrokes required for the tasks you wish to perform.

Avoid using:

■ the tab or arrow keys in your macro because the cursor may not always be in 
the same position each time a window opens.
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■ mouse clicks and movements, because the macro recorder does not record 
them.

Use keyboard shortcut keys instead to perform actions in the application.

NOTE:  When a macro is executed, it can be impacted by the current 
keyboard settings of the client PC. Care should be taken to ensure 
that keyboard settings, such as Caps Lock, are not inadvertently left 
on. Agents should also be cautioned not to enter keystrokes while a 
macro is running, since that can also affect the macro.

Shortcut keys are indicated by an underlined letter in the button name, field name, or 
description. You press Alt, Ctrl, or Shift plus the underlined letter to perform the 
action. For instance:

In this case, pressing Alt-E clicks the Edit button.

The exact keystrokes for a keyboard shortcut are listed in the application’s menu. For 
instance, in Microsoft Word, to find out what the shortcut is to save a document, 
choose File from the menu bar. On the drop-down menu the Save option is followed by 
its shortcut, Ctrl-S.

Common Windows shortcut keys are:

Shortcut Key Description

Esc Cancels an action.

Enter Clicks OK or the default button in a dialog box. (Default buttons 
have a heavier border surrounding them.)

Ctrl-A Selects all text.

Ctrl-C Copies selected text to the clipboard.

Ctrl-P Prints the document.

Ctrl-S Saves the document.

Ctrl-V Pastes text into the window at the cursor position.

Ctrl-X Cuts selected text to the clipboard.
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A macro may include keystrokes for multiple applications. For example, one macro 
may include keystrokes for word processing, spreadsheet, and database applications. 
To switch between applications when recording a macro, use the mouse to select the 
application. Do not press Alt-Tab. If you do, these keystrokes are recorded and may not 
select the correct application when you play back the macro.

NOTE:  Do not press Ctrl-Esc to click the Microsoft Windows Start 
button, or the Macro Recorder stops recording without providing a 
message showing that recording has stopped. All keystrokes recorded 
up to this point are deleted. To click Start without causing an error or 
stopping recording, use your mouse.
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Allowed Macro Keystrokes

Table 14. Allowed Macro Keystrokes—Keys

Key Type Key Macro Notation

Character 0 1 2 3 4 5 6 7 8 9

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

* + ; = , - . / ` [ \ ] '

Non-Character Tab [TAB]

Backspace [BACKSPACE]

Enter/Return [ENTER]

Shift [SHIFT]

Control/Ctrl [CONTROL]

Alt [ALT]

Pause/Break [PAUSE]

Caps Lock [CAPSLOCK]

Esc [ESC]

Space/Space Bar [SPACE]

Page Up/PgUp [PAGE-UP]

Page Down/PgDn [PAGE-DOWN]

End [END]

Home [HOME]

Left Arrow [LEFT-ARROW]

Up Arrow [UP-ARROW]

Right Arrow [RIGHT-ARROW]

Down Arrow [DOWN-ARROW]

Print Scrn [PRINTSCREEN]

Insert [INSERT]

Delete [DELETE]

F1 through F24 [F1] … [F24]
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Recording Macros

Follow these steps to record a macro.

To record a macro:

1. Start any third-party applications you want to include in the new macro, and 
then minimize them.

2. Set up a new action. See "Adding a New Action" on page 123.

The Select Action window appears.

3. Select the Run Macro tab, and then click New.

The New Macro dialog box appears.

4. Enter a new macro action name, and then click OK. 

The Macro Editor window appears (see Figure 79).

Table 15. Allowed Macro Special Commands

Special Command Description

[ENTERPRISE FIELD:] Inserts an Enterprise Data field.

[DATA FIELD:] Inserts data from Agent Desktop.

[SYSTEM FIELD:] Inserts data from Agent Desktop system fields.

[APPLICATION:=] Changes focus to an application window. The equal 
sign ( = ) is used as a separator between the 
application and the window title. If either the 
application name or window title is missing, Agent 
Desktop attempts to find the correct application and 
window to play the macro to, based on the 
parameters present.

[DELAY] Time, in milliseconds, to wait before performing the 
next macro command.

Example: [DELAY] 1000 delays the next macro key 
or command by 1 second.
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Figure 79. Macro Editor window (with a macro script displayed; the window name is the name 
of the macro).

5. Click Record. 

The Macro Editor window minimizes and the macro recorder starts. Anything 
you type from now on is entered in the new macro.

6. Maximize the third-party application and begin typing.

The macro recorder records your keystrokes.

7. If you wish to insert an Agent Desktop data field into the macro, press the 
Pause Macro hot key (the default is F2). 

The Macro Recorder Suspended dialog box appears (see Figure 80). 

NOTE:  Do not change the window focus away from the third-party 
application to the macro recorder before pressing the Pause Macro 
hot key and inserting a data field. If you do this, you will receive an 
error message and your macro recording will be interrupted.

Figure 80. Macro Recorder Suspended dialog box.
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8. Click Insert Data.

The Select a Data Field dialog box appears (see Figure 81). See "Data Fields" 
on page 150 for more information.

Figure 81. Select a Data Field dialog box.

9. Choose the desired data field from the list, enter test data if desired, and then 
click OK. 

The test data you enter is displayed in the application only when the macro is 
tested using the Playback function.

The Macro Recording Suspended dialog box appears.

10. Click Resume Recording to continue recording the macro.

11. Once you have finished recording the macro, press the macro hot key.

The Macro Recording Suspended dialog box appears.

12. Click End Recording.

You are returned to the Macro Editor window. 

13. You can take any of the following actions:

■ Click OK to save the macro as recorded.

If there are no errors, the macro is saved and you are returned to the 
Select Action dialog box. 

If there are errors, the macro editor displays the line and highlights the 
text in question. Correct it and click OK again. 

■ Click Playback to test the macro.

If there are errors, the macro editor displays the line and highlights the 
text in question. Correct it and click Playback again.

If there are no errors, the macro is played back. If it works as you want it 
to, click OK to save it and return to the Select Action dialog box.
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To change test data, choose Data > Change Test Data in the macro editor 
and enter new test data.

■ Click Cancel to cancel the macro.

The macro is canceled and the Select Action dialog box appears.

Data Fields

The Select a Data Field dialog box (Figure 81) enables you to select and insert a Agent 
Desktop data field into a macro. Access this dialog box either through the Suspend 
Macro Recording dialog box or from the Data menu in the Macro Editor window.

There are three types of data fields:

■ Standard. Data from the switch.

■ System. System data, for example the date and time. These fields are 
enclosed in square brackets [ ].

■ Enterprise. Data from the Enterprise service. These fields are marked with an 
asterisk ( * ).

NOTE:  When selecting data fields to be used in actions or rules, keep 
in mind that not every data field is available for every event. For 
example, the calling number is not available during the Startup event. 
If an unavailable field is used, <N/A> is displayed in the application 
the macro pops.

These fields can be included in the Run Macro and Launch External Application work 
flow actions. 

The available data fields are:

Table 16. Enterprise Data Fields 

Data Field Description

*Account Number The customer’s account number.

*Alerting Number The number of the ringing device.

*ANI The number of the phone that made a call.

*Application Data The ISDN user-to-user information element.

*BAAccountNumber Outbound Dialer: The customer’s account number.

*BABuddyName Outbound Dialer: The customer's first and last name 
separated by a comma.
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*BACampaign Outbound Dialer: The name of the campaign to which 
the call belongs.

*BADialedListID Outbound Dialer: Unique key identifying a specific 
customer record within the Dialing_List table located in 
the BA private database.

*BAResponse Outbound Dialer: Multi-purpose placeholder that sends 
data from Agent Desktop to the BA Dialer. This variable 
responds to the reservation call, schedule and cancel 
callbacks, and changes to the callback phone number.

*BAStatus Outbound Dialer: Two characters indicating the mode 
and direction of the BA Dialer-initiated call. The first 
character identifies the call mode:

• R: Reservation call, Predictive or Progressive mode

• P: Reservation call, Preview mode

• C: Customer call

• A: Reservation call, personal callback

During a reservation call, the first character is P, R, or 
A. When a customer call is transferred to an agent, the 
first character is C.

The second character of BAStatus indicates the call 
direction:

• O: Outbound

• I: Inbound

• B: Blended

Table 16. Enterprise Data Fields — <Emphasis>Continued

Data Field Description
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*BATimeZone Outbound Dialer: Indicates the GMT offset, in minutes, 
for the customer’s time zone and obtains the 
customer’s local time. The format of this ECC variable 
is +/-#####.

This field’s first character is either a positive or 
negative sign, followed by 5 digits. For example:

• This example indicates that the customer is one 
hour behind GMT:

BATimeZone = -00060

• This example indicates that the customer is two 
hours ahead of GMT:

BATimeZone = +00120

*Call Duration The difference between the call’s end time and start 
time. The time is read from the Enterprise server’s 
clock.

*cisco.com.Category Reserved for future use.

*cisco.com.MessageKey Reserved for future use.

*cisco.com.Priority Reserved for future use.

*Collected Digits Digits entered by the caller in response to IVR 
prompting.

*DNIS The number of the phone that received a call.

*ICM Call Variable 1… 
*ICM Call Variable 10

Call-related variable data. There are 10 available 
variables.

*Last Called Number The last number dialed.

*Last Calling Number The last device that made a call.

*Last Connected 
Number

The last monitored device that joined the call.

*Last Queued Time The amount of time spent in queue the last time the 
call was queued. The time is read from the Enterprise 
server’s clock.

*Last Redirection 
Number

The last number the call was redirected from.

*Layout The name of the enterprise data layout.

Table 16. Enterprise Data Fields — <Emphasis>Continued

Data Field Description
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Set Enterprise Data Action

This action enables you to set one enterprise data field variable that appears in the 
Cisco Agent Desktop enterprise data pane to a desktop variable or static text of your 
choosing. 

The action is available only for the Ringing and Answered events. 

NOTE:  Do not include a Set Enterprise Data action in the same work 
flow as the following Call Control actions: supervised transfer, blind 
transfer, conference, or blind conference. This can cause a critical 
race condition that results in the enterprise data not being available.

To set up a Set Enterprise Data action:

1. Set up a new action. See "Adding a New Action" on page 123.

*Trunk ID Device ID of the trunk.

*UCID Not applicable.

[AGENT_ID] The agent’s identification.

[CALL_DURATION] The difference between the call’s end time and start 
time. The time is read from the agent’s PC’s clock.

[CALL_END_TIME] The end time of the current call. If the call has not yet 
ended, it is the current time. The time is read from the 
agent’s PC’s clock.

[CALL_START_TIME] The start time of the current call. If there is no call, this 
data is empty. The time is read from the agent’s PC’s 
clock.

[COMPUTER_NAME] The name of the computer the agent is currently logged 
onto.

{LOCAL_PHONE_EXT] The agent’s extension.

Alerting# The number of the ringing phone.

Called# The number of the phone that received a call.

Calling# The number of the phone that made a call.

Original Called# The original number that received a call.

Original Calling# The original number that made a call.

Table 16. Enterprise Data Fields — <Emphasis>Continued

Data Field Description
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The Select Action window appears.

2. Select the Set Enterprise Data tab, and then click New.

The Set Enterprise Data Action Setup Editor dialog box appears (see Figure 
82).

Figure 82. Set Enterprise Data Action Editor dialog box.

3. Complete the dialog box as follows:

4. Click OK.

Timer Action

This action is available to CAD agents at the Enhanced and Premium levels. 

Field Description

Action Name Enter a name for the new action.

Enterprise Data 
Field to Set

Select the enterprise data field you whose content 
you want to set. Only ICM call variables and all 
user-created ECC variables are available for 
selection from the drop-down list. 

Select one of the following data sources:

Desktop Variable From the drop-down list, select the desktop variable 
you want to be entered automatically in the 
enterprise data field. Your choices are Agent ID, 
System Name, System Time, or Skill Group.

Static Text Enter the static text you want to be entered 
automatically in the enterprise data field. Maximum 
length of text is 210 characters. 
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The timer action enables you to trigger Agent State, HTTP, or Agent Notification actions 
after a certain amount of time has elapsed under specified circumstances. 

For instance, you can configure the Timer action to change the agent’s state to Ready 
if the agent has been in the Work Ready state for 3 minutes. 

To set up a Timer action:

1. Set up a new action. See "Adding a New Action" on page 123.

The Select Action window appears.

2. Select the Timer Action tab, and then click New.

The Timer Action Setup dialog box appears (see Figure 83).

Figure 83. Timer Action Setup dialog box.

3. Complete the Timer Action Setup dialog box as follows:

Field Description

Action Name Enter a name for the new action.

Timer 
Duration

Set the amount of time the agent must spend in the 
selected agent state before the action executes.

Timer 
Expiration 
Work Flow 
Setup section

In this section, specify the actions that will execute when 
the time duration has expired. You can specify that the 
agent state must also be equal or not equal to either 
Ready or Not Ready.
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4. Click Add to select or set up the actions you want to execute when the timer 
has expired.

5. When you have configured the Timer Expiration Work Flow, click OK.

Utility Action

There are three utility actions:

■ Start recording

■ Stop recording

■ Send a predefined, high-priority chat message to the agent’s supervisor

High Priority Chat Messages

A high priority chat message is a predefined message that appears in a supervisor’s 
Chat window (see Figure 84). The message behaves just like a regular chat message 
that is tagged as high priority—it pops up on the supervisor’s screen on top of all other 
windows to attract the supervisor’s attention. 

You can configure a task button on the Agent Desktop toolbar to send such a message 
from an agent to the agent’s supervisor(s). 

NOTE:  For CAD-BE agents, a high priority chat message can be sent 
but it cannot be replied to by the supervisor, because CAD-BE agents 
do not have chat capability.

Figure 84. Sample high-priority chat message.

To set up a utility action:

1. Set up a new action. See "Adding a New Action" on page 123.

The Select Action window appears.
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2. Select the Utility Action tab, and then click New.

The Utility Action Setup dialog box appears (see Figure 85).

Figure 85. Utility Action Setup dialog box.

3. Enter a name for the new action, select an action type from the drop-down list, 
and then click OK.

■ If you select Record as the action type, select Start or Stop from the 
Action field. 

■ If you select HighPriorityChat, type the message you want to send as the 
predefined, high-priority chat message in the Message field.

NOTE:  When the dialog box initially opens, only the Action Name and 
Action Type fields are visible. When you choose the Record action 
type, the Action field appears. When you choose the High Priority 
Message action type, the Message field appears.

NOTE:  If a Record action is part of a voice contact work flow, the 
agent being recorded will see a recording icon in the contact 
appearance pane even if notification is turned off. 
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Cisco Unified Outbound Dialer

Cisco Unified Outbound Dialer is an ICM/Unified Contact Center Enterprise feature 
that enables automated outbound dialing to customers. These outbound calls appear 
as inbound calls to the agent, and information about the call appears in the Enterprise 
Data pane.

NOTE:  Unified Outbound Dialer is available only for Agent Desktop.

NOTE:  Cisco Unified Mobile Agent call-by-call mode does not support 
Outbound Dialer. Nailed mode does support Outbound Dialer.

A supervisor or administrator sets up a calling campaign in ICM that consists of 
various elements that will present calls to agents and provide information so the 
agent can handle the call successfully. (See the Cisco ICM/IP Contact Center 
Enterprise Edition Setup and Configuration Guide for information on setting up calling 
campaigns.)

Outbound Dialer has four modes that determine what type of dialing is done to make 
the outbound calls:

■ Predictive Dialing Mode. In this mode, agents are reserved and a number of 
customers are dialed simultaneously. When a customer is contacted, the call 
is transferred to an available reserved agent. The customer’s data is 
displayed in the agent’s Enterprise Data window. Predictive dialing mode 
optimizes agent usage by calculating the average time an agent waits to 
receive a call and their average call handling time to determine the number of 
lines to dial per agent so that wait time is kept to a minimum.

■ Progressive Dialing Mode. This mode is similar to Predictive Dialing mode, 
except that the system does not calculate the number of lines to dial per 
agent. Rather, the user configures a fixed number of lines to be dialed per 
agent.

■ Preview Dialing Mode. In this mode, an agent is reserved and then presented 
with a customer call along with customer information in the Enterprise Data 
window. Based on this information, the agent can decide to accept, skip, or 
reject the call. 

■ Direct Preview Dialing Mode. This mode is similar to Preview Dialing mode, 
except that the agent can categorize the phone call presented as Voice, 
Answering Machine, Invalid, and Fax Modem.

All four dialing modes use the personal callback feature. This features enables an 
agent to reschedule a customer call at the customer’s request for a more convenient 
time. 
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Callbacks can be configured so that, when the call is redialed, the call is directed to 
any agent (regular callback) or the call is directed to the agent who made the callback 
reservation (personal callback). The callback type is configured at the campaign level 
and is not controlled by the agent. 

Outbound Dialer Actions

Based on the enterprise data information, the agent selects the appropriate Outbound 
Dialer action button on the Outbound Dialer toolbar.

The available Outbound Dialer actions are:

■ Accept. The system dials the customer and connects the call to the agent.

■ Reject. The system rejects the current call and releases the agent from the 
outbound calling reservation. At this point, the system may deliver to the 
agent another outbound call or a new inbound call.

■ Reject Close. The system rejects the current call and closes the record so the 
customer will not be called again.

■ Skip. The system skips the current call and presents the agent with another 
customer call.

■ Skip Close. The system skips the current call and closes the record so the 
customer will not be called again.

■ Skip Next. The system skips the call and displays a menu of these options: 

— Wrong Number. The agent is informed that the number called is a wrong 
number. After the call terminates, the system calls other customer phone 
numbers.

— Not Home. The agent is informed that the customer is not home. After the 
call terminates, the system calls other customer phone numbers.

■ Callback. Displays the Callback Properties dialog box, which the agent uses to 
set a time and date to call back the customer. This action is enabled only if 
the agent is in the talking or wrap-up agent state. The agent also uses this 
dialog box to cancel a previously-scheduled callback of the current customer. 
This action works only if the agent is in a talking or wrap-up state during an 
ICM-generated call. 

■ Reclassify. Displays a menu that enables the agent to reclassify a customer 
phone number as voice, answering machine, fax/modem, or an invalid 
number.

■ Cancel Reservation. The system releases the agent from the calling campaign 
and places the agent in the Not Ready state. To resume participating in the 
calling campaign, the agent must change the agent state to Ready. 
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Outbound Dialer Toolbar

In order for the Outbound Dialer actions to be available for agents to use, you must 
configure the agent interface to include the Outbound Dialer toolbar. 

The dialing mode used in the calling campaign determines which buttons appear in 
the toolbar (see Table 17).

To configure the Outbound Dialer toolbar to display in Agent Desktop:

1. In the User Interface window, select the Toolbar tab. 

2. In the Outbound Dialer Mode section, select the check box next to the dialing 
mode used by your calling campaign (see Figure 86). 

The appropriate buttons are enabled in the button selection pane.

3. Click Apply to save your changes.

The Outbound Dialer toolbar will now appear on the Agent Desktop interface.

Table 17. Outbound Dialer toolbar buttons and the dialing mode  
in which they appear. 

Icon Button Dir. Preview Predictive Preview Progressive

Accept × ×

Reject × ×

Reject Close × ×

Skip × ×

Skip Close × ×

Skip-Next × × × ×

Callback × × × ×

Reclassify ×

Cancel 
Reservation

× × × ×
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Figure 86. Toolbar tab of the User Interface window.

Outbound Dialer Enterprise Data

In order for Outbound Dialer enterprise data to appear in the Enterprise Data window, 
you must edit the Default layout to include some or all Outbound Dialer fields (see 
Table 18). All Outbound Dialer fields are prefixed with the letters “BA”.

See "Layouts" on page 55 for information on editing the Default layout. 

Table 18. Cisco Outbound Dialer enterprise data fields 

Variable Comment

BAAccountNumber [200]

BABuddyName [201]

BACampaign [202]

BADialedListID [203] Required for Preview and Direct Preview dialing 
modes in order for the Skip function to work

BAResponse [204]
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BAStatus [205] Required for all dialing modes. If this field is not 
included in the layout, no other Outbound Dialer 
fields will be displayed.

If a call is part of a Preview dialing mode 
campaign, the first letter in the BAStatus field 
entry is a P. If a call is part of a Direct Preview 
dialing mode campaign, the first letter is a D.

BATimeZone [206] Required for all dialing modes in order for the 
Callback function to work.

Table 18. Cisco Outbound Dialer enterprise data fields — <Emphasis>Continued

Variable Comment
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Unified CCE Configuration
Introduction

The Unified CCE Configuration node enables you to configure the websites that 
supervisors use to dynamically re-skill their agents (see Figure 87).

Figure 87. Unified CCE Configuration node.

By default, the websites listed under Agent Re-Skilling are not configured. This node 
enables you to specify alternative websites to the default Cisco Unified Contact Center 
Enterprise Web Administration Agent Re-skilling website.
163



Cisco Desktop Administrator User Guide
Alternate Agent Re-Skilling Websites

You can specify two alternative agent re-skilling websites to appear in Cisco 
Supervisor Desktop’s Tools menu (see Figure 88).

Figure 88. Cisco Supervisor Desktop Tools menu.

By default, these menu options both lead to the default Cisco Unified Contact Center 
Enterprise Web Administration Agent Re-skilling website on the ICM. 

To set up an alternative agent re-skilling website:

1. Under the Agent Re-skilling node, select Site 1 or Site 2. 

2. In the right pane, clear the Use Cisco’s Re-skilling tool check box. 

The URL field and Apply button are enabled.

3. Enter the URL of the alternative site you want supervisors to use, and then 
click Apply.

NOTE:  You cannot change the display name. 

To remove an alternative agent re-skilling website:

1. Under the Agent Re-skilling node, select the site you want to return to the 
default re-skilling website.

2. Select the Use Cisco’s Re-skilling tool check box, and then click Apply.

Agent Re-skilling Notes

■ Any changes you make to the re-skilling website location are not registered by 
Cisco Supervisor Desktop until it is restarted.
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■ Any URL you enter is not checked by the system for accuracy.

■ You can enter up to 256 characters in the URL field.

■ You an enter any type of URL (for example, http, https, file, or ftp).
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Personnel Configuration
Introduction

Personnel Configuration allows you to view information about agents, supervisors, and 
teams within a logical contact center.

Some of the data for agents, supervisors, and teams is configured in Cisco Intelligent 
Contact Management (ICM) and is only viewable, not editable, from within Desktop 
Administrator. 
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Agents

The Agents window (see Figure 89) displays a list of all the agents configured in ICM. 

From this window you can view an agent’s properties and change the agent’s work 
flow group affiliation. You can also select the method of login for both agents and 
supervisors—by agent ID or by agent name.

NOTE:  When using System IPCC, the only option supported is login by 
login name. If you are not using System IPCC, run CAD Configuration 
Setup and reset this option. See the Cisco CAD Installation Guide for 
more information.

You cannot change the agent’s user ID, password, display name, or team name—that 
information must be administered through ICM.

Figure 89. The Agents window.

To view an agent’s properties:

1. Select the agent from the agent list, and then click Properties.

The Agent Properties dialog box appears (see Figure 90).

2. Click OK to close the window after reviewing the agent’s properties.
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To change agents’ login method:

■ Click either Agent ID or Agent Name to select which an agent should use to log 
into Agent Desktop. 

NOTE:  If an agent attempts to log in at the same time you change the 
login method, the agent will receive an error message. The agent 
must restart Agent Desktop and then use the new login method.

Changing an Agent’s Work Flow Group

An agent can belong to only one work flow group at a time. All agents are assigned to 
the Default work flow group until reassigned to another one.

To change an agent’s work flow group:

1. Select the agent from the agent list, and then click Properties.

You can also double-click or right-click the agent’s name to display the 
Properties dialog box.

The Agent Properties dialog box appears (see Figure 90).

2. Select a work flow group from the drop-down list, and then click OK.

The agent is now assigned to a new work flow group.

Figure 90. Agent Properties dialog box.

Field Description

ID The agent’s Agent Desktop/IP Phone Agent user ID

Login Name The agent’s login name
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Display Name The agent’s name, as seen in Agent 
Desktop/Supervisor Desktop

Team Name The team to which the agent is assigned

Work Flow Group The work flow group that controls the agent’s desktop 
and work flow configurations

Field Description
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Supervisors

The Supervisors window (see Figure 91) displays a list of all the supervisors 
configured in ICM. 

From this window you can view a supervisor’s properties and change the supervisor’s 
password (it can also be changed from within Supervisor Desktop). 

You cannot change the supervisor’s user ID, display name, or team affiliation—that 
information must be administered through ICM. 

Figure 91. The Supervisors window.

To view supervisor properties:

1. Select the supervisor from the supervisor list, and then click Properties.

You can also double-click or right-click the supervisor’s name to display the 
Properties dialog box.

The Supervisor Properties dialog box appears (see Figure 92).

2. Click OK to close the window after reviewing the supervisor’s properties.

Changing a Supervisor’s Password

Initially, a supervisor’s password is blank. The supervisor can then change the 
password to what he or she wants.

In the event the supervisor forgets the password, you can reset it from the Supervisor 
Properties dialog box. The supervisor can then change that password to one of his or 
her own choosing.
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To change a supervisor’s password:

1. Select the supervisor from the supervisor list, and then click Properties.

The Supervisor Properties dialog box appears (see Figure 92).

2. Enter a new password in the Password field (it will appear as asterisks), and 
then click OK.

The password is changed.

Figure 92. The Supervisor Properties dialog box.

Field Description

ID The supervisor’s Supervisor Desktop user ID

Password The supervisor’s password

Login Name The supervisor’s login name

Display name The supervisor’s name as seen in CAD/CSD

Team/Type pane The team the supervisor is assigned to, and the type of 
supervisor (primary or secondary)
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Teams

The Teams window enables you to view the supervisors, agents, and skills for a 
particular team. All this information is administered through ICM. You can only view 
the information in Personnel Configuration.

Supervisors

The Supervisors tab (see Figure 93) displays the primary supervisor, secondary 
supervisors, and available supervisors for the team you selected. 

NOTE:  Each team must have a primary supervisor. If there is no 
primary supervisor, secondary supervisors will not see that team in 
the Team List in Supervisor Desktop. Also, if that team is a secondary 
supervisor’s only team, the supervisor won’t be able to log into 
Supervisor Desktop.

Figure 93. Supervisors tab.

Agents

The Agents tab (see Figure 94) displays a list of the agents who belong to the team 
you selected, as well as a list of all available agents. Agents are assigned to teams 
from within ICM.

NOTE:  An agent can belong to only one team in ICM. However, the 
Available Agents pane lists all agents not on the selected team, even 
if they are already assigned to another team.
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NOTE:  If you move an agent from one team to another in ICM, you 
must log the agent out of CAD and then log back in for the team 
change to register within Supervisor Desktop.

Figure 94. The Agents tab.

Skills

The Skills tab displays a list of the skill groups that route calls to the selected team, as 
well as a list of all available skill groups. This relationship is set up within ICM.

Figure 95. The Skills tab
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NOTE:  Due to the way ICM works, an ICM-generated default skill 
group will be displayed in Available Skills pane. This skill group’s 
name is usually a long string of numbers. For example, in Figure 95, it 
is 000271607568. No agents are assigned to this skill group, and it 
can safely be ignored.
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Tutorials
Introduction

This chapter shows you how to perform a number of common tasks. The tasks are 
presented as tutorials, and each task includes step-by-step instructions and keystroke 
macro examples. 

The tutorials are based on a fictional company called Rock Coast Products. The 
tutorials are:

■ Setting Up an ANI-Based Screen Pop (page 178) 

■ Using a Terminal Emulator Package (page 182)

■ Setting Up a Task Button to Transfer to a Specified Number (page 187)

■ Setting Up a Task Button for After-Call Work (page 188)

■ Setting Up a Launch External Application Action (page 197)

■ Using Wild Card Data Conditions (page 198)

NOTE:  The macros used in these tutorials may need fine-tuning, 
depending on the PC used and the third-party software accessed.
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Setting Up an ANI-Based Screen Pop

Premise

Rock Coast Products wants to use the ANI as the basis for a screen pop containing 
customer contact information.

Procedure

Set up a macro to search for the ANI in a Microsoft Outlook 2000 contact list.

NOTE:  This example uses Microsoft Outlook 2000 SR-1(9.0.0.3821). 
If you have a different version, your keystrokes may vary.

1. Start Microsoft Outlook. 

2. In the Navigation pane of Desktop Administrator, click Desktop Configuration 
> Work Flow Groups > Agents, select a work flow group, and then click Voice 
Contact Work Flow.

3. Create a new work flow, and configure it so that it applies to all inbound calls.

The Voice Contact Work Flows window appears (see Figure 56 on page 114). 

4. Select Ringing from the Events list box, and then click New under the Rules 
area.

The New Rule Name dialog box appears.

5. Enter a name (for example, CustContact), and then click OK.

The new rule appears in the Rules list.

6. Select the new rule, and then click Edit next to the first Data Field Conditions 
field.

The Data Field Conditions dialog box appears (see Figure 57 on page 115)

7. Select Calling# from the Data Field drop-down list, check the Is Not Empty 
data field filter, and then click OK.

The Data Field Conditions dialog box closes.

8. Click Any Condition is True.

9. Click Add under the Actions area to create a new action for the event.

The Select Action dialog box appears.

10. In the Select Action dialog box, select the Run Macro tab and then click New.

11. In the New Macro dialog box, enter a new macro action name (for example, 
LookUpPhoneNumber) and then click OK.

The Macro Editor dialog box appears.

12. In the Macro Editor dialog box, note that the macro name entered in step 11 
appears in the title bar. Click Record.
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The Macro Editor dialog box minimizes.

13. Use your mouse to maximize Outlook and begin typing the following macro 
keystrokes; the Macro Recorder records your keystrokes.

14. Click Insert Data. 

The Select a Data Field dialog box appears.

15. Select the CALLING# data field from the list, and then click OK.

The Macro Recording Suspended dialog box appears.

16. Click Resume Recording and enter the remaining macro keystrokes, shown 
below.

17. The macro is now complete. To test it, click Playback.

You can make changes to the macro in the edit window, and you can test the 
changes by clicking Playback.

Macro Keystrokes Action

ALT-V Access the View menu

G Select Go to…

O Select Contacts

ALT-T Access the Tools menu

D Select Advanced Find

ALT-C Moves the cursor to the Search for the 
word(s) field

Press F2 (or whichever key 
has been set up as the 
macro hot key)

Pause macro recording and bring up the 
Macro Recording Suspended dialog box

Macro Keystrokes Action

ALT-I Selects the In field

P Toggles to the Phone number fields only 
option

ALT-N Clicks the Find Now button

Press F2 (or whichever key 
has been set up as the 
macro hot key)

Pause macro recording and bring up the 
Macro Recording Suspended dialog box
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NOTE:  You might see multiple [ALT] entries in the macro. These are 
extraneous and can be deleted. If left in the macro, they will not 
cause errors.

18. Once you are satisfied with the macro, click OK to save it and add it to the list 
of available macros that can be selected as actions.

19. Select the new macro and click OK. 

The Voice Contact Work Flow window appears. Notice that the macro has 
been added to the list of actions for the selected rule and event.

Macro Text

The following text appears in the Macro Editor dialog box:

[APPLICATION:RCTRL_RENWND32=INBOX - MICROSOFT OUTLOOK]
[ALT] V
G
O
[ALT] T
D
[APPLICATION:RCTRL_RENWND32=ADVANCED FIND]
[ALT] C
[DATA FIELD:CALLING#]
[ALT] I
P
[ALT] N

Now you must record a second macro to close the Advanced Find dialog box. Make 
sure to keep Outlook and the Advanced Find dialog box open.

1. In the Voice Contact Work Flow window, select Dropped from the Events list 
box.

2. Under the Actions list, click New to create a new action.

3. In the Select Action dialog box, select the Run Macro tab and then click New.

4. In the New Macro dialog box, enter a new macro action name (for example, 
CloseAdvFind) and then click OK.

5. In the Macro Editor dialog box, note that the macro name entered in Step 4 
appears in the title bar. Click Record.

The Macro Editor dialog box minimizes.

6. Use your mouse to maximize the Advanced Find dialog box and begin typing 
the following macro keystrokes; the Macro Recorder records your keystrokes.

Macro Keystrokes Action

ALT-F Access the File menu
180 June 2007



Setting Up an ANI-Based Screen Pop
NOTE:  You must add a delay at the beginning of the macro. See 
“Macro Text” below.

7. Once you have finished recording the macro, press the macro hot key to bring 
up the Macro Recording Suspended dialog box, and then click End Recording.

8. To test your macro, click Playback.

9. Once you are satisfied with the macro, click OK to save it and add it to the list 
of available macros that can be selected as actions.

10. Select the new macro and click OK.

The Voice Contact Work Flow window appears. Notice that the macro has 
been added to the list of actions for the selected rule and event.

Macro Text

The following text appears in the Macro Editor dialog box:

[DELAY] 1500
[APPLICATION:RCTRL_RENWND32=ADVANCED FIND]
[ALT] F
C

C Close the Advanced Find dialog box

Press F2 (or whichever key 
has been set up as the 
macro hot key)

Pause macro recording and bring up the 
Macro Recording Suspended dialog box
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Using a Terminal Emulator Package

Premise

Rock Coast Products would like to use a terminal emulation program to find the 
caller’s name based on the ANI, and then automatically create an e-mail message 
each time a call is received.

Steps

This example uses the following software:

■ Terminal emulation software: HostExplorer for Windows 95/98, file version 
6.1.0.0. from Hummingbird Communications, Ltd.

■ E-mail program: Microsoft Outlook 98 (8.5.5104.6)

Use two macros since each can potentially be reused with other actions. It is easier to 
create and debug small macros and then run them as two actions in a sequence to do 
larger tasks. 

■ The first macro accesses the terminal emulation program and copies the 
caller’s name to the clipboard.

■ The second macro copies the number from the clipboard and uses it in an 
e-mail message.

NOTE:  Terminal emulation packages can be unpredictable when 
used with macros. The keyboard/terminal emulation must be correct 
for the macros to record and play back correctly. Some terminal 
emulation packages do not have a provision for highlighting and 
copying text from a screen.

Make sure both programs are running before recording the macros. Also make sure 
that the terminal program is logged in to a server, and open a text file using Vi (a Unix 
editor). The text file layout is shown below:

Phone         NumberName
612-555-2000  Spanlink Communications
612-555-1234  John Smith
612-555-0000  Mary Nelson
612-555-5555  Ned Marvin

Set up the Vi macro:

1. Open Vi, log into the server, and open the text file.

2. Start Desktop Administrator, click Voice Contact Work Flow, and add a new 
action for the Ringing event.

3. In the Select Action dialog box, click New in the Run Macro dialog box.

4. Enter a new macro action name (for example, GetNamePutInClipBoard) and 
then click OK.
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5. In the Macro Editor dialog box, click Record. 

The Macro Editor dialog box minimizes.

6. Maximize Vi, and begin typing the following macro keystrokes; the macro 
recorder records your keystrokes.

7. In the Macro Recorder Suspended dialog box, click Insert Data.

The Select a Data Field dialog box appears.

8. Select the data field you wish to insert from the list, and then click OK.

The Macro Recording Suspended dialog box appears.

9. Click Resume Recording. Begin typing the following keystrokes.

Macro Keystrokes Action

H Place the cursor in the “home” position

/ Search

F2 (or whichever key has 
been set up as the macro 
hot key)

Pause macro recording and bring up the 
Macro Recorder Suspended dialog box

Macro Keystrokes Action

ENTER Search

Positioned on the Phone Number field

/ Search

<SPACE> Search for a space to get to the Name 
column

ENTER Search

Positioned after the Phone Number field

L Move right one character (over the first 
space)

L Move right one character (over the second 
space)
June 2007 183



Cisco Desktop Administrator User Guide
10. Once you have finished recording the macro, press the macro hot key to bring 
up the Macro Recorder Suspended dialog box, and then click End Recording.

The Macro Editor window appears.

11. To test your macro, click Playback. You can make changes to the macro in the 
Edit window, and you can test the changes by clicking Playback.

12. Once you are satisfied with the macro, click OK to save it and add it to the list 
of available macros that can be selected as actions.

13. Select the new macro and click OK.

The Voice Contact Work Flow window appears. Notice that the macro has 
been added to the list of actions for the selected rule and event.

After you have recorded both macros, notice that both appear in the Actions pane. 
Make sure that they appear in the order shown in Figure 96.

Figure 96. Macros in the Actions pane.

Vi Macro Text

The following text appears in the Macro Editor dialog box:

[SHIFT] [CONTROL] 
[RIGHT-ARROW]

The next three key stroke combinations 
select the caller’s name

[SHIFT] [CONTROL] 
[RIGHT-ARROW]

[SHIFT] [CONTROL] 
[RIGHT-ARROW]

[ALT]-E Vi Edit menu

C Copy the selected text to the clipboard

Press F2 (or whichever key 
has been set up as the 
macro hot key)

Pause macro recording and bring up the 
Macro Recorder Suspended dialog box
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[APPLICATION:HOSTEXPLORER=1 - DEFAULT (DEACON)]
[SHIFT] H
/
[DATA FIELD:CALLING#]
[ENTER]
/
[SPACE]
[ENTER]
L
L
[SHIFT] [CONTROL] [RIGHT-ARROW]
[SHIFT] [CONTROL] [RIGHT-ARROW]
[SHIFT] [CONTROL] [RIGHT-ARROW]
[ALT] E 
C

Outlook Macro Text

The following text appears in the macro recorder dialog box:

[APPLICATION:RCTRL_RENWND32=INBOX - MICROSOFT OUTLOOK]
[SHIFT] [CONTROL] B
[APPLICATION:ABCLS=ADDRESS BOOK]
[ALT] Y 
[CONTROL] V
[CONTROL] N
[SHIFT] R
E
G
A
R
D
I
N
G
[SPACE]
[SHIFT] Y
O
U
R
[SPACE]
[SHIFT] C
A
L
L
[SPACE]
O
N
[SPACE]
[SYSTEM FIELD:CALL_START_TIME]
[TAB]
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[SHIFT] D
E
A
R
[SPACE]
[CONTROL] V
.
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Setting Up a Task Button to Transfer to a 
Specified Number

Premise

Rock Coast Products wants to set up a call control button that will allow agents to 
easily transfer calls to their supervisor.

Steps

1. In Desktop Administrator, click Desktop Configuration > Work Flow Groups > 
Agents and select a work flow group, and then click User Interface.

The User Interface window appears.

2. On the Toolbar tab, select the task button you want to configure.

3. Select the Visible check box.

4. Type a brief hint to describe the action (for instance “Xfer to Super”) in the hint 
field.

5. Click Add.

6. In the Select Action dialog box, select the Call Control tab, and then click New.

7. In the Setup Call Control Action dialog box, enter a name for the action in the 
Action Name field, select the call control type, and then enter the supervisor’s 
telephone number in the Phone Number field.

8. Click OK to save the settings.

9. On the Call Control tab, the new action is highlighted. Click OK.

10. On the Toolbar tab, the new action is now associated with the task button you 
are configuring.

11. Click OK to save the changes.
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Setting Up a Task Button for After-Call Work

Premise

Rock Coast Products wants to set up a task button that prepares a Microsoft Outlook 
2000 e-mail message for after-call work.

This example retrieves customer information (e-mail address, name, and amount of 
sale) from an Access 2000 database and pastes that information into an Outlook 
2000 e-mail message. 

Assumptions

■ The agent has been looking at the customer’s record in the Access database 
in form view

■ Outlook is open on the agent’s desktop and is displaying the In Box.

■ The agent reviews the automatically-generated e-mail and sends it manually.

Steps

1. In Desktop Administrator, click Desktop Configuration > Work Flow Groups > 
Agents, select a work flow group, and then click User Interface.

The User Interface Setup window appears.

2. On the Toolbar tab, select the task button you wish to configure.

3. Select the Visible check box.

4. Type a brief hint to describe the action (for instance “After Call Email”) in the 
hint field.

5. Click Add.

6. In the Select Action dialog box, select the Run Macro tab and then click New.

The New Macro dialog box appears.

7. In the New Macro dialog box, type a name for the new macro (for instance, 
“AfterCallEmail”), and then click OK.

The Macro Editor window appears.

8. Click Record to start recording the macro.

9. Use your mouse to maximize Access, and then begin typing the following 
macro keystrokes; the macro recorder records your keystrokes.

Macro Keystrokes Action

[HOME] Press Home to position the cursor in the 
first field in the form.

[TAB] Press the tab as many times as needed to 
go to the e-mail address field.
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10. Use your mouse to maximize Outlook, and then type the following macro 
keystrokes.

[CONTROL] C Copy the e-mail address.

[HOME] Press Home to position the cursor in the 
first field in the form.

[CONTROL] N Open a blank e-mail message.

[CONTROL] V Paste the e-mail address in the To: field in 
the e-mail message.

[TAB] Tab down to the Subject line.

[TAB]

[SHIFT] Y Type “Your Order” in the Subject line.

O

U

R

[SPACE]

[SHIFT] O

R

D

E

R

[TAB] Tab to the body of the message.

[SHIFT] D Type the salutation “Dear ”

E

A

R

[SPACE]
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11. Use your mouse to maximize Access, and then type the following macro 
keystrokes.

12. Use your mouse to maximize Outlook, and then type the following macro 
keystrokes.

[TAB] Tab as many times as needed to get to the 
Name field.

[CONTROL] C Copy the customer’s name.

[CONTROL] V Paste the customer’s name after the 
salutation.

[ENTER] Press the Return key twice to start a new 
line for the body of the message.

[ENTER]

[SHIFT] T Type the message: “Thank you for your 
order in the amount of ”.

H

A

N

K

[SPACE]

Y

O

U

[SPACE]
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F

O

R

[SPACE]

Y

O

U

R

[SPACE]

O

R

D

E

R

[SPACE]

I

N

[SPACE]

T

H

E

[SPACE]

A

M

O

U
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13. Use your mouse to maximize Outlook, and then type the following macro 
keystrokes.

N

T

[SPACE]

O

F

[SPACE]

[TAB] Tab as many times as needed to get to the 
Amount of Sale field.

[CONTROL] C Copy the amount of sale.

[CONTROL] V Paste the amount of sale in the body of the 
message.

. Add a period to the sentence.

[SPACE] Type “Your order is in the mail.” to finish 
the e-mail message.

[SHIFT] Y

O

U

R

[SPACE]

O

R

D

E

R

[SPACE]
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14. Once you have finished recording the macro, press the macro hot key to 
display the Macro Recording Suspended dialog box, and then click End 
Recording.

15. To test your macro, click Playback. You can make changes to the macro in the 
Macro Editor window and then test them by clicking Playback again.

To slow down the macro so you can watch the steps, insert the command 
[DELAY] 1000 before and after the commands for maximizing Outlook and 
Access. This will help you debug the macro. For instance:

[DELAY] 1000 
[APPLICATION:OMAIN=MICROSOFT ACCESS - [CUSTOMERS : FORM]
[DELAY]1000

16. Once you are satisfied with the macro, click OK to save it and add it to the list 
of available macros that can be selected as actions.

17. On the Run Macros tab, the new macro is highlighted. Click OK to return to the 
User Interface Setup window.

18. In the User Interface Setup window’s Toolbar tab, the new macro action is now 
associated with the task button you are configuring.

19. Click OK to save the changes.

I

S

[SPACE]

I

N

[SPACE]

T

H

E

[SPACE]

M

A

I

L

.
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Sample Macro Text

The following text appears in the macro recorder dialog box:

[APPLICATION:OMAIN=MICROSOFT ACCESS - [CUSTOMERS : FORM]
[HOME]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[CONTROL] C
[APPLICATION:RCTRL_RENWND32=INBOX - MICROSOFT OUTLOOK]
[CONTROL] N
[APPLICATION:RCTRL_RENWND32=UNTITLED - MESSAGE (PLAIN TEXT) ]
[CONTROL] V
[TAB]
[TAB]
[SHIFT] Y
O
U
R
[SPACE]
[SHIFT] O
R
D
E
R
[TAB]
[SHIFT] D
E
A
R
[SPACE]
[APPLICATION:OMAIN=MICROSOFT ACCESS - [CUSTOMERS : FORM]
[HOME]
[TAB]
[CONTROL] C
[APPLICATION:RCTRL_RENWND32=YOUR ORDER - MESSAGE (PLAIN TEXT) ]
[CONTROL] V
,
[ENTER]
[ENTER]
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[SHIFT] T
H
A
N
K
[SPACE]
Y
O
U
[SPACE]
F
O
R
[SPACE]
Y
O
U
R
[SPACE]
O
R
D
E
R
[SPACE]
I
N
[SPACE]
T
H
E
[SPACE]
A
M
I
[BACKSPACE]
O
U
N
T
[SPACE]
O
F
[SPACE]
[APPLICATION:OMAIN=MICROSOFT ACCESS - [CUSTOMERS : FORM]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
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[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[CONTROL] C
[APPLICATION:RCTRL_RENWND32=YOUR ORDER - MESSAGE (PLAIN TEXT) ]
[CONTROL] V
.
[SPACE]
[SHIFT] Y
O
U
R
[SPACE]
O
R
D
E
R
[SPACE]
I
S
[SPACE]
I
N
[SPACE]
T
H
E
[SPACE]
M
A
I
L
.
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Setting Up a Launch External Application 
Action

Premise

Rock Coast Products wants to set up a task button that automatically launches a 
third-party application.

Steps

In this example you set up an action that launches Microsoft WordPad and then 
associates the action with a task button on the agent’s toolbar.

1. In Desktop Administrator, click Desktop Configuration > Work Flow Groups > 
Agents, select a work flow group, and then click User Interface.

The User Interface Setup window appears.

2. On the Toolbar tab, select the task button you want to configure.

3. Select the Visible check box.

4. Type a brief hint to describe the action (for instance, “WordPad”) in the hint 
field.

5. Click Add.

6. In the Select Action dialog box, select the Launch External Application tab, 
and then click New.

7. In the Setup Launching External Application Action dialog box, enter a name 
for the action in the Action Name field and browse to the application’s 
executable (Wordpad.exe) in the Application field.

Remember that the application should be located on a network drive so it is 
accessible to all agents. If you must use an application located on the agent’s 
PC, make sure that the application is accessible by an identical path on each 
agent’s PC.

8. If you want, add any of the available arguments to pass to WordPad. Select 
the arguments from the right Available Arguments pane and use the left and 
right arrows to add or remove them to the left Arguments pane. Use the up 
and down arrows to rearrange the order in which they will appear.

9. Click OK to return to the Launch External Application tab with the new action 
highlighted in the list of actions. 

10. Click OK to return to the User Interface Setup window.

11. In the User Interface Setup window’s Toolbar tab, the new action is now 
associated with the task button you are configuring.

12. Click OK to save the changes.
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Using Wild Card Data Conditions

Premise

Rock Coast Products is located in a city with two neighboring area codes. The east 
metro area code is 651 and the west metro area code is 612. Rock Coast’s Customer 
Service Division has one agent who assists east metro callers and one agent who 
assists west metro callers.

If an east metro caller dials the main Customer Service number, Rock Coast wants 
that call directed automatically to the agent who handles east metro calls.

To separate east metro callers, Rock Coast sets up rules using the data conditions Is 
in the List and Is not in the List. These data conditions return as true only if there is an 
exact string match. 

Entering hundreds or even thousands of telephone numbers into a list is not feasible, 
so Rock Coast uses wild card data conditions. This operation is similar to the function 
of the Find tool in Windows. You can enter part of a string or a whole string to find 
what you’re looking for. See "Wild Card Searches" on page 116 for more information 
on using wild cards.

Procedure

Set up a wild card data condition that will transfer calls from the 651 area code to the 
east metro agent:

1. In Desktop Administrator, click Desktop Configuration > Work Flow Groups > 
Agents, select a work flow group, and then click Voice Contact Work Flow.

The Voice Contact Work Flow window appears.

2. Select the Default voice contact work flow, and then click Edit.

The Voice Contact Work Flow window appears.

3. Select the Ringing event.

4. Under the Rules pane, click New.

5. Create a new rule named East Metro.

6. In the Voice Contact Work Flow window, note that the new rule appears in the 
Rules list. With the new rule highlighted, click Edit next to the first Data Field 
Conditions field.

7. Select Calling# from the Data Field drop-down list.

8. Check Enable Condition.

9. Check Is in the list.

10. Add the wild card data condition 651* to the list.

11. Click OK, and then click Apply.
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Glossary
ACD
See automatic call distribution.

action
An occurrence that takes place when a rule is met. More than one action can take 
place as a result of meeting a rule.

administrator
The person who administers Cisco Agent Desktop. The administrator defines work 
flows and teams, and the look and feel of the agent’s desktop.

agent
The person who interacts with customers in a contact center. 

Agent Desktop
The Cisco desktop application used by a contact center agent to handle customer 
calls.

agent state
An agent’s current ACD status. Possible statuses are Ready, Not Ready, Work 
Ready, Work Not Ready, Reserved, Hold, Talking, and Logged Out.

Agent State action
An action type that changes an agent’s ACD agent state.

Always on Top mode
A display mode in which the interface is always on top of all other windows and 
does not minimize.

Always Open mode
A display mode in which the interface is always visible, but may be hidden by other 
open applications.

ANI
See automatic number identification. 
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area code
A 3-digit code designating a toll center in the United States and Canada.

array variable
An ICM extended call context (ECC) variable that stores multiple pieces of data.

automatic call distributor (ACD)
Optional software that resides on the PBX. Its role is to monitor various parameters 
within the system and call center and to intelligently route calls based on that 
information. 

automatic number identification (ANI)
A series of digits at the front of a phone call that delivers the billing number (which 
is not necessarily the phone number) of the caller.

barge-in
A feature in Supervisor Desktop that allows a supervisor to forcibly join an agent’s 
call with a customer. It is a forced conference call.

bridged appearance
A situation in which two devices share the same phone number (for example, a 
secretary whose phone can also answer the boss’s phone). 

Browser and IP Phone Agent (BIPPA) service
The service that enables CAD-BE and IP phone agents to log in and out of ICM, 
change agent states, and enter wrap-up data and reason codes without having the 
Agent Desktop software. This service works in conjunction with the Services 
feature of Unified CM and Cisco IP phones.

CAD-BE
Cisco Agent Desktop—Browser Edition. A Java applet version of Cisco Agent 
Desktop that runs in a web browser.

call activity data
The information displayed Agent Desktop documenting the length of time a call is 
at a particular type of device or agent within the call center. 

call center
A location where calls are made and answered. A call center typically has 
numerous agents and an automatic call distributor. 

call control
The action of changing the state of a call, for instance, making, answering, 
transferring, or dropping a call.

Call Control action
An action that performs a call control function triggered by an event meeting a rule. 
Call control actions vary according to switch type.
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call history
See call activity data.

call log
The record of calls made and received by a desktop while running Agent Desktop.

call routing
The automatic sending of calls to the desired destination, such as an extension or 
a queue.

caller input
Touchtone data entered by the caller in response to prompting.

CallManager
A Cisco software-based voice over IP telephone switch.

Chat
A feature of Agent Desktop and Supervisor Desktop that enables agents and 
supervisors to communicate via an instant messaging window.

Chat service
A service that acts as a message broker between the Chat clients and Supervisor 
Desktop. It is in constant communication with all agents and supervisor desktops. 

chat session
A written exchange between agents or between agent and supervisor using the 
Chat application.

Cisco Unified Mobile Agent
Cisco Unified Mobile Agent provides the capability to use remote agents when 
staffing contact centers. It provides an encrypted, secure, IT-managed connection 
over broadband to the home. The agents have complete access to all the contact 
center applications. 

Computer telephony integration (CTI)
The connection of a computer with a telephone switch that allows the computer to 
issue commands and receive event information for calls and agents. 

configuration file
The computer file that stores the settings for an application.

contact center
An expansion of a call center, so that it can make and receive not only phone calls, 
but email, faxes, web chat messages, and so on.

CORBA
Common Object Request Broker Architecture. An architecture and specification for 
creating, distributing, and managing distributed program objects in a network. It 
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allows programs at different locations and developed by different vendors to 
communicate in a network through an interface broker.

country code
The 1–3 digit code that, in the world numbering plan, identifies each country or 
integrated numbering plan in the world.

CTI
See computer telephony integration.

data field
A piece of information about a phone call that is available for display in the Agent 
Desktop interface. 

data field condition
A logical statement about call data that evaluates as either true or false.

data router
In networks, a device that connects any number of IP local area networks (LANs).

data switch
In networks, a device that filters and forwards packets between LAN segments.

database
A collection of data structured and organized in a disciplined fashion so that 
information of interest can be accessed quickly.

deflected call
A ringing call that is redirected to another extension without being answered first. 
This typically happens when the call is answered by voice mail.

delimiter
A word or character that marks the beginning or end of a segment of data.

Desktop Administrator
The application used to administer Cisco Agent Desktop.

device
A unit (for example, a telephone) connected to the telephone system. 

Dial Pad
The soft phone screen that enables an agent to dial a number.

dial plan
A description of the dialing arrangements for customer use on a telephone 
network. For example, the local access code, local area code, etc.
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dialed number information service (DNIS)
A telephony network feature that provides the number the caller dialed.

Directory Services 
Also known as LDAP. The service that all other CAD services register with at 
startup. Clients use this service to request information about other CAD 
components.

DNIS
See dialed number information service.

drop
To hang up or disconnect a phone call.

Dropped event
An event which indicates a call is disconnected.

DTMF
See Dual Tone Multi-Frequency.

dual tone multi-frequency (DTMF)
The term for touchtone dialing. In DTMF, when you touch a button on a push 
button pad, it makes a tone which is actually a combination of two tones, one high 
frequency and one low frequency. These are the beeps you hear when you dial a 
phone number.

duplex environment
An operating environment that contains a primary and secondary service. If the 
primary service fails, the secondary service takes over.

ECC variable
See expanded call context variable.

enterprise data
A piece of data available to CAD via the Enterprise service.

Enterprise service
A server program that tracks calls in the system. It is used to attach IVR-collected 
data to a call in order to make real-time call activity data available at the agent 
desktop.

Ethernet
A local area network standard. Like other LAN technologies, Ethernet is used to 
connect computers, printers, workstations, terminals, servers, and other devices 
within the same building or campus.
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event
An occurrence at the agent desktop. Events include: startup, shutdown, ringing, 
answered, and dropped. 

expanded call context variable
An ICM term for a piece of information about a phone call. It must be defined 
within ICM.

extension
The internal telephone number at the agent desktop.

external application
A software application not belonging to CAD.

host
A server connected to a network.

ICM
See Intelligent Contact Management.

Install Manager
The program that helps you install CAD on your system.

Intelligent Contact Management (ICM)
A Cisco computer telephony integration application that collects data and profiles 
customers from the network to the agent’s desktop, and coordinates the delivery 
of voice and data to a targeted answering resource across the enterprise. Using 
network-provided data, caller-entered digits, and information obtained from a 
customer profile database, ICM determines who is calling and why, and routes the 
call to the appropriate area in the contact center.

interactive voice response (IVR)
The use of a computer to interact verbally via a telephone with a caller. The 
computer plays announcements and questions to the caller, and the caller replies 
by entering information via touch tones, a rotary dial, or by speaking. “IVR” and 
“VRU” are often used interchangeably. See voice response unit (VRU).

intercept
An intercept occurs when a supervisor uses the Intercept button to force a transfer 
from an agent to the supervisor. 

Internet protocol (IP)
This protocol specifies the format of packets, also called datagrams, and the 
addressing scheme. Most networks combine IP with a higher-level protocol called 
transport control protocol (TCP), which establishes a virtual connection between a 
destination and a source.

IP by itself is something like the postal system. It allows you to address a package 
and drop it in the system, but there’s no direct link between you and the recipient. 
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TCP/IP, on the other hand, establishes a connection between two hosts so that 
they can send messages back and forth for a period of time.

IP
See Internet protocol.

IP address
The Internet protocol address of a device. 

IP Contact Center (IPCC)
Now known as Cisco Unified Contact Center (CC). A Cisco solution for an IP contact 
center. Its components include IP IVR, Unified CM, and ICM.

IP IVR

Cisco IP IVR is an IP-powered interactive voice response application that provides 
an open and extensible foundation for the creation and delivery of IVR solutions 
via Internet technology. It automates the handling of calls by autonomously 
interacting with users. 

IP phone
A phone that enables you to move multimedia traffic over any network that uses 
Internet protocol (IP).

IP port
In TCP/IP and UDP networks, an endpoint to a logical connection.

IPCC
See IP Contact Center.

IVR
See interactive voice response.

LAN
See local area network.

Launch External Application action
An action that starts an external application from within Agent Desktop. 

LCC
See logical contact center.

LDAP
See lightweight directory access protocol.

LDAP Monitor service
The service that starts Directory Services and then monitors it to ensure that it 
keeps running.
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LDAP service
The service that all other CAD services register with at startup. Clients use this 
service to request information about other CAD components.

License Administration
The application used to update the number of seats purchased in your CAD 
system.

Licensing and Resource Manager service
The service that distributes licenses to clients and oversees the health of the CAD 
services. In the event of a service failure, it initiates the failover process.

lightweight directory access protocol (LDAP)
Also known as Directory Services. LDAP defines a standard manner of organizing 
directory hierarchies and a standard interface for clients to access directory 
servers. 

local area network (LAN)
Two or more computers, and other devices, connected by cable, generally within 
the same building or campus.

local extension
See extension.

logical contact center (LCC)
The root of the LDAP tree where CAD applications query for information. It is used 
to segregate logically separate call centers within the LDAP server.

macro
A series of prerecorded commands that accomplish a task. 

macro hot key
In Desktop Administrator, the key used to pause the recording of a macro and to 
display the macro recording menu.

macro recorder
The feature in Desktop Administrator used to record a macro.

Normal mode
A display mode in which the interface appears when calls are present and 
minimizes when idle.

pane
Section of an application window.

password
A series of alphanumeric characters required to log onto an application or server.
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PBX
See private branch exchange.

peripheral ID
The number within the ICM schema that identifies the peripheral device, for 
example, the peripheral interface managers (PIMs) for VRU/IVR, ACD, or Unified 
CM.

phone book
In Agent Desktop, any one of the stored phone directories. Agent Desktop contains 
global phone books as well as an employee phone book.

plain old telephone service (POTS)
The basic service supplying standard telephones, telephone lines, and access to 
the public switched network. 

port
See IP port.

POTS
See plain old telephone service. 

primary server
In a duplex environment, the main server used. If the primary server fails, the 
secondary server takes over.

private branch exchange (PBX)
A private telephone network used within an enterprise. Users of the PBX share a 
certain number of outside lines for making telephone calls external to the PBX. 

PSTN
See public switched telephone network. 

public network
A network operated by common carriers or telecommunications administrations 
for the provision of circuit switched, packet switched, and leased-line circuits to 
the public.

public switched telephone network (PSTN)
Refers to the world’s collection of interconnected voice-oriented public telephone 
networks, both commercial and government-owned.

real-time transport protocol (RTP)
An Internet protocol for transmitting real-time data such as audio and video.

recent call list
A list of an agent’s 100 most recently made phone calls, automatically kept in the 
Dial Pad window. 
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Recording & Playback service
The service that extends the capabilities of the VoIP Monitor service by allowing 
supervisors and agents to record and play back calls.

Recording & Statistics service
A service that maintains a 7-day history of agent and team statistics. It also 
manages call recording.

Ringing event
The event that occurs when the phone rings. See Event.

RTP
See real-time transport protocol. 

rule
A set of 1–3 data field conditions. If any or all the conditions that constitute the 
rule are evaluated as true, then the rule is met. Rules that are met trigger events 
and actions.

Run Macro action
An action that starts and runs a macro.

scalar variable
An extended call context (ECC) variable that stores a single piece of data.

screen pop
The delivery of caller-specific information onto the agent’s computer screen 
(“populating” the screen).

seat
An instance of Agent Desktop, Supervisor Desktop, or other CAD applications. 

secondary server
In a duplex environment, the backup server. If the primary server fails, the 
secondary server takes over. 

shortcut key
A keyboard key or key combination (also known as a “hotkey” or “keyboard 
accelerator key”) that invokes a particular command that is generally faster to use 
than clicking the mouse through a menu. 

Shutdown event
The event that occurs when Agent Desktop shuts down. See event.

skill
An ability (expertise in a particular type of software, fluency in a foreign language, 
for example) of a contact center agent. Calls can be routed based on agent skills 
(skill-based routing) for better customer service. 
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soft phone
A software phone, such as Agent Desktop’s dial pad. 

Startup event
The event that occurs when Agent Desktop starts up. See event. 

status bar
The area on the Agent Desktop or Supervisor Desktop interface that displays the 
status of the agent and of the CAD system.

Stealth mode
A display mode in which an application appears as an icon in the system tray 
unless maximized by the agent.

supervisor
The leader and/or manager of a team of agents.

Supervisor Desktop
The application used by contact center supervisors to manage agent teams in real 
time.

Sync service
The service that connects to the ICM logger SQL database via and ODBC 
connection and retrieves agent, supervisor, team, and skill information. It then 
compares the information with the information in Directory Services and adds, 
updates, or deletes entries as needed to stay consistent with the ICM 
configuration.

task button
One of a series of up to 10 buttons on the Agent Desktop interface to which 
actions can be assigned. 

team
A group of agents who report to the same supervisor.

Team Performance Message (TPM)
A message the supervisor can create to display in Agent Desktop for a set length of 
time to communicate important information. The TPM can be scrolling or 
non-scrolling, depending on how the supervisor configures it.

threshold
The acceptable amount of time a call can remain at a particular device or call 
center. Caution or warning icons are displayed in the Enterprise Data window when 
thresholds are met or exceeded for a call. 

touch tones
See dual tone multi-frequency. 
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TPM
See Team Performance Message.

transfer
A phone switch feature that allows moving a call from one extension to another.

transfer, blind
A transfer in which the active call is transferred to the third party without ensuring 
that the transfer is successful (picked up at the other end).

transfer, supervised
A transfer in which you speak to the third party to whom the call is being 
transferred before connecting the active call, in order to confirm that the transfer 
can be made successfully.

user ID
An identifier that designates a particular user and that is required to log into an 
application or server.

user interface
An application’s look and feel to the user. 

virtual private network (VPN)
A network created by renting or acquiring some part of someone else’s network (a 
phone company, an Internet provider) and used to communicate between a 
company’s offices.

voice gateway router
A combination of hardware and software that links a POTS telephone network to 
an IP data network. 

voice monitoring
The ability of a supervisor to monitor an agent’s phone conversations without 
being heard and without letting the agent knowing it is happening.

voice packet
A digitized sample of a voice conversation sent over a network.

voice response unit (VRU)
The computer used to interact verbally via a telephone with a caller. The computer 
plays announcements and questions to the caller, and the caller replies by 
entering information via touch tones, a rotary dial, or by speaking. “VRU” and “IVR” 
are often used interchangeably. See interactive voice response (IVR).

voice-over IP (VoIP)
A category of hardware and software that enables people to use Internet protocol 
as the transmission medium for telephone calls.
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Voice over IP Monitor service
A service that enables supervisors to silently monitor agents. The service 
accomplishes this by “sniffing” network traffic for voice packets.

VoIP
See Voice over IP.

VPN
See virtual private network.

VRU
See voice response unit.

wild card
Special characters used to represent one or more characters in a string. An 
asterisk (*) represents several characters and a question mark (?) represents a 
single character.

work flow
A sequence of actions that takes place when specific event/rule criteria are met. 

work flow group
A group that shares a common set of work flows. 
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Global Phone Book FAQ
Question Is there a way to mass-import records to Cisco Agent Desktop global phone 
books? 

Answer No, there is no way that phone book entries can be entered in bulk. All entries 
must be done manually through Cisco Desktop Administrator.

Question Where are global phone books stored?

Answer They are stored in the Directory Services (LDAP) database at  
SpanlinkCommunications > Company > [LCC name] > PhoneBook.

Question How are phone books synchronized between the active and standby Directory 
Services in a redundant system?

Answer Whenever an entry is made in the active Directory Services, it is immediately 
replicated on the standby system so that they remain synchronized. 

Question Which logs should be collected to troubleshoot issues with global phone books?

Answer The Cisco Agent Desktop and Cisco Desktop Administrator logs (agent.log and 
administrator.log) and debug traces, set to the DEBUG level, (agent.dbg and 
administrator.dbg) are used to troubleshoot phone book issues.

Question Where are global phone books configured?

Answer Global phone books are created and populated by the administrator using Cisco 
Desktop Administrator. Agents cannot edit global phone books. They can edit their 
own employee phone books using Cisco Agent Desktop. 

The administrator can enable and disable all phone books, or just employee 
phone books. See "Phone Books" on page 78 for instructions on administering 
phone books.
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Question Do phone books run from the Directory Services database?

Answer Earlier versions of CAD loaded phone books from Directory Services every time 
the agent launched the dial pad. The current version of CAD loads phone books 
once and stores them in memory to avoid delays. 

Question Can global phone books be linked back into the Cisco Unified Communications 
Manager/Unified CallManager LDAP user list so that it is available from the IP 
phone corporate directory? 

Answer No.

Question Are phone books available to agents when they use their non-ACD extension? 

Answer No. 

Question Is there a maximum number of entries that can be put into a phone book?

Answer No, phone book size is limited only by the memory available to the agent’s 
desktop. Phone books have been tested with up to 2,000 entries.

Question Can a global phone book be locked down so that only members of a certain team 
can view it?

No, global phone books are either available to all agents or no agents. However, 
there are work flow group phone books that are available to agents that are 
assigned to that particular work flow group. If a team is assigned to a work flow 
group, and there is a specific phone book for that work flow group, than no other 
teams can view that particular phone book. See "Phone Books" on page 78 for 
more information on the various types of phone books.
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Cisco Desktop Monitoring Console
Overview

The Cisco Desktop Monitoring Console is a Java application that monitors the status 
of the CAD services and Directory Services (LDAP).

The Monitoring Console requires Tomcat to run. Tomcat is automatically installed with 
the CAD base services.

NOTE:  The Monitoring Console is installed automatically when the 
CAD base services are installed. There is some manual setup and 
configuration that is required. See the Cisco CAD Installation Guide 
for more information.

The Monitoring Console application is located on any computer where the CAD base 
services are installed. The URL for a hyperlink to the application is:

http://<CAD Services IP address>:8088/smc/monitor.jsp
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Using the Monitoring Console

The Monitoring Console consists of 2 panes. The left pane displays a list of CAD 
servers and the CAD services located on those servers. The right pane displays either 
a summary view or a detail view of service status. 

The summary view is displayed when you select the IP address of a server from the 
left pane (see Figure 97). The detail view is displayed when you select a specific 
service (see Figure 98).

Figure 97. Cisco Desktop Monitoring Console, summary view
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Using the Monitoring Console
Figure 98. Cisco Desktop Monitoring Console, detail view

The services’ status is indicated also by a colored icon next to each service in the left 
pane. If the service is running, a green circle is displayed; if the service is down, a red 
circle with a white X through it is displayed.

If a server is down, a gray computer with a white X through it is displayed.

NOTE:  Currently, the summary view and the detail view display the 
same information in different ways. In the future, more service details 
will be added to the detail view.

The information displayed, including the server list in the left pane, is refreshed every 
15 seconds. It can also be manually refreshed at any time by clicking the Refresh 
Server List button. 
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